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1 Activate license - Help tab 
 

 

Picture 1: Help tab 

  

From this tab you can activate your version of MatDeck, preview a document and list the 
examples for better and easier usage of the application. 

 

 

 

Picture 2: Activate license 

 

 

Picture 3: User manual 

 

 

Picture 4: Documentation 

 

When you press the Activate licence icon , a 
window shown on Picture 2 will open. Enter the 
key that you have purchased on the LabDeck site 

and press Activate.  

To successfully activate your version of MatDeck 
you must have internet access. 

 

 

When you press the User Manual icon , a 
new MatDeck document will appear with links to 

several manuals and tips (Picture 3). 

 

 

When you press the Docs icon , a new 
MatDeck document shown on Picture 4 will open 
with links to the User Manuals, Tips, lessons and 
examples. You can get familiar with MatDeck if 

you walk through Lessons and learn more about 
the possibilities of the software through the 

presented examples. 
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Picture 5: Software updating 

 

 

  

MatDeck automatically checks for software 
updates every time you open the application. If 

newer versions are available, a message will 
appear on the screen asking if you would like to 

update your version of MatDeck. 

If you want to check for updates manually whilst 
the software is running, press the Update icon 

from the Help tab. 
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2 MatDeck basics 
 

Default layout when you start MatDeck application with one document opened. 

 

Picture 6: MatDeck desktop 

The desktop consists of the following elements: 

2.1. Documents list area: List of opened documents 

2.2. Document area: work area for creating and editing documents, inserting text, formulas, 
graphs, table and other objects. 

2.3. Insert area: This area consists of several tabs from which you can insert Mathematical 
functions, logical operations, symbols, constants, units, shapes and lines and other objects. 
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2.1 Document list area 
 

 

Picture 7:Document list 

2.2 Document area 
 

 

Picture 8: Document preview 

This is a working area in which all opened documents are shown. When a new document is 
created it will appears like a new tab on top of the area with generic name Document1. 

There are two types of MatDeck documents, regular document and script document. The 
extension for both document types is .mdd and the main difference is that in script documents you 
can only type and insert MatDeck script language, and in regular MatDeck documents you can insert 
all types of object (scripts as well). 

 

In this area you can see the list of documents 
that are open; 

When you right button click on 
 content menu will appear with 

the following options: New document, Open 
document, Open Url; 

Right button click on particular file will open 
content menu with options: Save, Save as 
(Read Only, Read Only Forbid Copy) and 

Close. 
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Regular document 

There are two main objects that can be placed in a regular document: text objects, which are default 
objects on every blank document, and canvas objects. Besides them, the Ctrl. + I key combination 
will turn on script mode and allow you to type script of your choice. To turn script mode off, use the 
same key combination. 

A canvas is a container object for several types of objects. In canvases we can place: formulas, 
create variables and expressions, vectors and matrices, graphs, images, comments, text boxes, 
bookmarks, tables, data objects, shapes, arrows, lines and trees. To insert a canvas, press the Canvas 
icon and click on an empty part of the document to place it. 

 

Column Mode  

When in Colum Mode, the MD Document is still a live document, with the only exception being the 
visual aesthetic of a traditional scientific paper. This allows the user to combine their actual working 
and proof with their written ideas and hypothesises. 

 

To turn it into column mode you will need to go Ctrl + L, this will toggle the document between 
columns and the standard writing mode. Once the document is column mode, the user may add 
Math objects and other MD features; these features will automatically be edited and rearranged to 
fit the column perfectly. For features or functions, the user will no longer need to insert a canvas; 
they may directly insert them into a column. 

 

For example, elements in the picture above can be inserted without a canvas and directly inside a 
column, the elements themselves will remain the same and evaluate and run as per normal. To 
insert an element, you will need to click on the element’s image, then you would like to place it. 
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Headers can also be easily inserted by double clicking on the top of any document, form there the 
user can type in any text as a header. The same can be done for footers. 

 

MatDeck also comes with a large array of editing features for editing. As you can see in the image 
above, you can change things such as font, size, colour, italics, bold, underline, colour, subscript, 
superscript and more such as paragraph and line spacing as well as indentations and centring. Look 
at the YouTube video for a MatDeck Scientific Report Paper. 

 

Script document 

In script documents, you can only write in the corresponding language, either Python or MatDeck 
Script Language. The document is not page based, instead you have one endless page to type scripts, 
which are the only content you can place in this type of documents. 
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2.2.1 Data types 
 

Data types that can be created and used in MatDeck application are: 

Boolean – a binary variable, having two possible values called “true” and “false”; 

Integer – a whole number, a number that is not a fraction; 

Double – a fraction number; 

Complex – imaginary number, which you can create by typing small letter i after whole or fraction 
number, without the use of spaces; 

Vector – a value of this type is fixed-length collection of values of certain type; 

Matrix – a value of this type is fixed-length and fixed-width collection of values of certain type; 

Table- a value of this type is fixed-length and fixed-width collection of values of certain type with 
name for each column; 
Symbolic value–a value of this type is any value containing symbol which can be multiplied or 
divided with another number, or can be powered; for example: 2a, -5x3, b-2, ...; 
Expression – a value of this type is a combination of symbolic values that can be added, subtracted, 
divided; for example: 2a+3b, -0.4c – 8.2d-1, ... 
Units - a value which stores a unit of measurement; 
String – a value in which we enclose a sequence of characters in double quotes and use them as a 
single values; 
Interval – a value that we use in equations and non-equations as a type of data for displaying 
results; 
Equation – a value that we use to store equations and non-equations in it; 
Symbolic function – a value which stores predefined function with symbolic arguments; 
Fraction – a value that represents a part of the whole number; 
Image – a value that is a data carrier for images. 
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2.2.2 Variables 
 

MatDeck variables are data holders where can store all types of data. You can place vectors 
and matrix in them, functions in symbolic or explicit form, other variables and expressions, ... 
To create variables with name X and Y type the following commands in the canvas: 

X :=5  Y:=3 

After creating a variable the letter or string of the variable name will change colour and by 
default become green. To change the colour of variables use Maths Settings option 
described in section 3.6.8. 

To display data saved in variable X simply type following command: 

X = 

And data will be displayed after the equal sign. Let’s create and display a few more variables 

Z :=X*Y  Z = 15 

T := sin(Y)  T = 0.141 

The number of decimal places in results can also be set from section 3.6.8. Program default 
angle unit are Radians, to see how to change it go to section 3.6.7. 
If you want to use variable G in definition of variable H, you must define variable G above 
the definition of variable H, otherwise G will be considered as a symbol in definition of H. 

To create a complex number and store it in a variable type the following command 

W := 5-4i 

Complex numbers are created when you use the small letter i in this case it will go after 
number 4, without use of spaces between. When complex a number is created, the letter i 
style will change and become italic. 
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2.2.3 Vectors and matrices 
 

There are two ways to create a vector or matrix in MatDeck. Vectors and matrix with a 
desirable size are created empty and you insert data in them afterwards.  
You can use Insert Matrix option from Maths tab where you choose desirable size of vector or 
matrix, as described in details in section 3.6.2. 

Let’s create a matrix 2x3 and insert data into it. Choose matrix size from Insert Matrix option, 
as shown on Picture 9, and an empty matrix will appear in the canvas 

        

Picture 9: Insert matrix 

If you wanted to store this matrix inside a variable, you should first create a variable a with 
command a := and repeat the above steps to create a matrix. You can insert data into the matrix 
simply by placing the cursor inside an empty node of the matrix and typing desirable data. 

You can process all the data in a matrix using a single arithmetic operator of function 

   

In MatDeck there is a group of functions called Matrix and Vector in which you can find a whole 
range of functions for data manipulation on vectors and matrix’s. For example,  

    

There are also several functions that will perform arithmetic operations with vectors or matrix, 
element-by-element rather than using a vector and matrix rules, and these are the following: mul for 
element-by-element multiplication, div for element-by-element division. For example, 

    

 



________________________________________________MatDeck 

15 
 

2.2.4 Using of functions 
 

There are a large number of functions that you can use in MatDeck. From the Functions tab 
you can see all available functions, they are divided into groups, there is a description for each of 
them and their arguments and also a few simple examples. To find out more about this topic, see 
section 2.3.3. 

As an argument of function you can enter variables that contain data you want to calculate or you 
can input values directly. When you start typing in a canvas Maths object, autosuggestion will 
appear to help you insert functions. The second way of inserting them is to double click on the 
preferred function from Functions tab while cursor is active in the canvas. 

We will create a variable X with value 25 in it, use function sqrt to calculate square root of variable X 
and place the result in a new variable Y. On the other hand we shall calculate the square root of 
number 25 directly. 

 

Depending on the functions and arguments, result can be single value (real or complex number), 
vector or matrix. 
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2.3 Insert area 
 

 

 

Insert area is divided in three groups: Basic Maths, Insert and Functions. 
We will walk through each group and all the tabs inside of them. 

2.3.1 Basic Maths 

2.3.1.1 Common tab 
 

 

Picture 10: Common tab 

 

2.3.1.1.1 Example: Operators 
 

Let’s write trigonometry/power series formula for sine function

using operators tab as much as we can. 

Solution: 

At the beginning we will create variable x and grant it value 2 with command x := 2, this 
variable will be used to check the results . Creating variable a allows us to store a formula 

expression, with command a :=, press  icon to create sum, press  to create fraction.  In the 

numerators position of fraction press  icon, insert -1 and press  icon, press  icon to create 

Common tab contains the most used 
mathematical functions and logical operators 

which are separated into five groups.   
They can be inserted only in the canvas math 

object, and we place it with a single click on it, 
while the cursor is active in canvas. 
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power over -1 and insert n into power position. Pressing the right keyboard arrow and cursor will 

leave power position, press icon, insert symbol x and press  icon to create a power over x, 

insert 2n+1 on power position. Now, move the cursor to the denominators position, press  icon, 

insert 2n+1 and press  icon, press  icon to create factorial.  Finally, place cursor on the sum 
lower border, insert 0, press right keyboard arrow to move the cursor on the upper border and 
insert it. To achieve the correct results to three decimal places, we will insert number 12 into upper 
border of sum. To check if the result is good enough, in new line insert a= to preview the result of 
value a, after that place the cursor anywhere in the canvas and type sin(2)=. Now we can compare 
results and conclude that the formula returns correct result. 

 

2.3.1.2 Symbols tab 
 

 

Picture 11: Symbols 

 

 

 

From this tab you can place various 
symbols in the document. They can be 
placed in text, formulas, tables and all 

other objects. 

On Picture 11 you can see a table of all the 
symbols that can be placed in the 

document. 

Symbols in this tab are divided in several 
groups: Greek Capital Letters, Greek Small 

Letters, Mathematical Symbols, All Symbols 
and Special Characters. Above them all is 

Recently Used Symbols group. 
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2.3.1.2.1 Example: Symbols 
 

Create a table of trigonometric identities for product to sum. 

Solution: 

First, let’s insert an empty table into the document. In the Place tab, press Table icon  
and choose a table of five rows and one column, click on the document and an empty table will 
appear in it. Place the cursor into the first row and type Product to sum, place it into the second 

row, type 2 cos and press  icon from Symbols tab, type cos again and press  icon from Symbols 

tab, press icon from Symbols tab, type cos, press , , , , ,  icons from Symbols tab, 

type cos, press , , , , icons from Symbols tab. 

 

 

We now finished the first identity, after repeating the procedure for other three we will 
have a table that looks like this 
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2.3.1.3 Constants tab 
 

 

Picture 12: Constants – Use tab 

 

 

Picture 13: Constants - Define tab 

 

 

 

In MatDeck, constants can be used as a part of 
Math object. 

 

This tab contains constants of all kind.  It is 
divided into two parts, Use and Define tabs. 

On the Use tab we can find predefined 
constants. Second column on Picture 12 shows 
us how constants will look like when we insert 
them into the document. The Third column is 

keywords for inserting constant through 
formulas. Every keyword begins with the letter c.  
For example, if we want to insert Euler’s number 

e we will type ce in the Math object.  

 

 

 

 

On the Define tab we can define new or remove 
existing constants.  

To define a new constant insert Constant Name, 
Constant Symbol and click on theAdd Constant 
button. Newly created constant will appear in 
constants list above, select it and define her 

value.  
To remove constants we have to mark 

theconstant on the list that we want to remove 
and press theRemove Constant button. 

Predefined constants can’t be removed, only 
subsequently created constants will be listed and 

only they can be removed.   
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2.3.1.3.1 Example: Constants 
 

In this example we are going to create new constants xyz and use it in the calculation of 
variable a defined as a = 15xyz/2e. 

Solution: 

Go to the Define tab, enter constant name and constant symbol and press Add Constant 
button. After constant will appear in constant list, select it and enter value. For this example we 
defined constant  
xyz = 4.72 m/s2. As you can see, we can define constant with or without units.  

Now, let’s create a new variable in document: type a :=, from Operators tab press  icon to create 
fraction, type 15 * cxyz in the numerators position (when we type cx the auto suggestion will display 
constant xyz that we created earlier, the system will automatically add letter c in front of the 
constant), in denominators position type 2*ce (ce command will create Oilers constant e). In a new 
Maths object type a=to view the value of the variable a.  

 

 

2.3.1.4 Units tab 
 

 

Picture 14: Units - Use & Set 

 

MatDeck documents allow us to use units in 
calculations as a part of Maths object.  

If we define numerical value with units, the 
calculation in which we use that numerical value 

will be in units as well. 

Tab Use & Set contains predefined units divided 
in to groups. All settings related to units are 

placed in this tab, main switch for showing units 
in document, system in which we want them to 

be shown (SI – International System of Units, 
USCS – United States Customary System), the 

way of displaying them (base or derived units), 
units style settings. Multiplication factor default 

state is multiplication and if it is set to other 
values it will multiply selected unit. 

For example, if we choose multiplication factor 
m (milli) and insert 5 A (amper) it will be defined 

as 5 mA.  
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Picture 15: Units – Define 

 

2.3.1.4.1 Example: Units 
 

If a base of rectangle is b = 83 meters and a height h = 45 feet, calculate the area of 
rectangle in square feet. 

Solution: 

We will first create variables base and height with given length. Type base:=83 and insert m 

after them, if option is checked letter m will become blue meaning that it will be 
consider as a unit. Let’s define another variable height:=45, and while cursor is behind the number 
45 press ft from All Units group. These are two ways for inserting unit in document, pressing the 
preferred unit from list of units while cursor is placed in the canvas, or by typing unit keyword 
directly into the document.  
After we created variables base and height, lets create variable P:=base*height and display her value 
in new Maths object P=. The unit in which the result will be shown as depends on what Result unit 
system we choose, as we are asked in this example to calculate area in feet squared, we shall choose 
USCS from square drop down menu. 

 

  

Tab Define, same as in Constants tab, we can use 
it to define new or remove existing units. 

To define a new unit insert Unit Group, Unit 
Name, Unit Symbol and click on Add Unit button. 
If we type a non existing unit group name in Unit 

Group field a new group will be created.Newly 
created units will appear in units list above, select 

it and define its value. 
To remove an existing unit, select the unit and 

click Remove Unit button. 
Predefined units can’t be removed, only 

subsequently created units can be removed. 
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2.3.2 Insert 
 

2.3.2.1 Shapes tab 
 

 

Picture 16: Shapes 

 

 

 

 

 

 

2.3.2.2 Arrows tab 
 

 

Picture 17: Arrows tab 

 

This tab is designed for inserting various types of 
shapes in documents and their formatting. They 

can be only placed in the canvas object. 

Shape object have text fields inside itself and 
when the shape is on focus we can resize it by 

moving surrounding blue boxes. 

Shape object has the following style settings: 
Line Color, Fill Color, Thickness and Dashed. 

When snap is active, centre of the shape object 
will be captured by snap. 

Arrows are links to the objects that can be 
connected to shapes or can stand alone. They 

can only be placed in canvas object. To connect 
an arrow to a shape, place the arrow head on the 

shape connecting circles (shown on above 
picture in the middle). 

When the arrow is on focus we can resize it by 
moving surrounding blue boxes. 

Arrows have the following style settings: Line 
Color, Fill Color, Thickness and Dashed. Also they 

have optional parameters: Head, Size and Tail 
Size this affects only arrows from the first row on 

Picture 17. 

Active snap does not affect arrow objects, so 
they can be placed freely on canvas, no matter if 

snap is on or off.  
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2.3.2.2.1 Example: Shapes and Arrows 
 

Draw a flowchart to find the largest amongst three different numbers entered by user. 

Solution: 

We will start with an empty canvas object, from Shapes tab we choose ellipse and click 
on the place that we wanted to position it inside the canvas. Object resize was done by moving blue 
rectangles placed around that object, we placed the cursor inside the text field of the shape and 
typed Start. To change the style of the inserted shape, select shape and from Shapes tab you can 
change Line colour and Fill colour, Thickness and Dashed options. 

 

Now, we will choose  shape and place it on the canvas, change its size by moving blue rectangles, 
change the shape style in the same way we changed the style of previous one and placed the cursor 

inside it to type Declare variables a, b and c. From Arrows tab choose  arrow and move cursor 
above first shape, five blue circles will appear representing the possible places to start the selected 
arrow, choose the one from the bottom of the shape, press and hold left mouse button and move 
cursor above second shape, choose the top blue circle on this shape and release the arrow. Click on 
this arrow and change its style from the Arrows tab changing its colour and thickness. From the head 

drop down menu choose this  option. 

 

Choose  shape, place it on the canvas, change its size, style and type Read a, b and c inside it. 

Again go to Arrows tab, choose  arrow and draw this arrow in the same way as we did with the 
previous arrow. Select the newly created arrow and change its style and head. 
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Place a new  shape, type is a >b? Inside, connect it with other shapes with  arrow and set 
the style and size for newly created shape and arrow. 

 

We will continue inserting shapes and arrows until we draw the whole flowchart from the picture 
bellow. 

 

 

The text True and False that lies on the arrows was created as an  object inserted from the 
Place tab. 
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2.3.2.3 Lines tab 
 

 

Picture 18: Lines 

 

 

 

 

 

 

 

 

 

 

2.3.2.3.1 Example: Lines and snap 
 

Draw resistor symbol for schematic diagram, one in an international IEC style and second in 
IEEE style. 
Solution: 

We will start with configuring of canvas grid and snap, so we draw these resistors as easily as 
we can. On the empty canvas object that we inserted from the Place tab->Canvas icon, press the 
right mouse button and choose the Properties option. Mark Show grid option and in the grid size 
field choose for example 10 px, and set the snap value to 4. We set grid size to such small value 
because we will zoom in on the document while we draw, so when we finish and zoom out to the 

default zoom the resistors will be precisely drawn and small enough. 
On the other hand, snap value were set to 4 this divides the grid 
square sides into four parts so we have a snap grid (invisible grid of 
snap) small enough for accurate drawing. 

Now we can start, from Lines tab choose Noninterpolated polyline, 
place cursor on the canvas, and hold left mouse button to start 

Lines tab is designed for inserting lines into the 
canvas object. There are five types of lines: 

Noninterpolated polyline, Interpolated polyline, 
Arc line, Circle Arc line and Circle line. 

When we draw lines there are two types of line 
points, blue rectangle and green rectangle 

points.  
The blue ones are points that can be moved with 

Ctrl. + left mouse click combination, deleted 
with a right mouse click and when you hold the 
left mouse click you can create two points from 

one.  
Green rectangle points can be used to create 
new points which originate from the selected 
green point. If we want to move green points 
without creating new segments, use Ctrl + left 

mouse click combination. 

Lines have the following style settings: Line 
Color, Thickness and Dashed. 

When snap is active, points of the line will be 
captured by snap (read more about snap setting 

on Canvas properties). 
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drawing a line. When you position the line on preferred place, release the mouse button and you 
have drawn your first line. As we already said the blue rectangle points are inner points that we can 
move with the left mouse click. Green rectangle points are the last points of the line whose 
movement creates new line segments. Continue with the drawing of resistor while pressing on the 
green rectangle points, hold the left mouse button and drag the cursor to place the end of the 
second point of the line in the preferred place. Continue this procedure until you have drawn whole 
resistor.  

During the creation of every line segment, snap will grab line endpoints making it easy to place them 
on preferred positions. After we create preferred form, we insert Text box items from Place tab and 
enter names of the resistors R1 and R2 inside. At the end resistors will looks like the ones on Picture 
19. 

 

  

 

 

 

 

 

 

2.3.2.4 Trees tab 
 

 

Picture 20: Trees 

 

 

 

 

  

Trees are predefined structures composed of 
shapes and arrows. They can be placed on the 

canvas objects. 

Every component of a tree can be moved up for 
itself. When the entire tree object is marked we 

can move it as one object. 

If one of the components of the tree is marked 
the corresponding tab will open depending on 
what object of the tree is marked. So if shape 

object is marked, the Shapes tab will open, and if 
we mark arrow object, Arrows tab will open. 

Active snap does not affect tree objects. 

Picture 19: Example - Resistors 
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2.3.3 Functions 
 

 

Picture 21: Functions 

 

 

 

 

 

 

Picture 22: Functions autosuggestion 

 

 

 

Functions area contains lists of all functions that can 
be used in MatDeck. The area is divided inn three 

ribbons: Groups ribbon, Functions ribbon and 
Arguments ribbon. 

Groups ribbon contains list of all function groups 
including Favorites group. 

 
Functions ribbon displays all functions that are in the 
selected group of Groups ribbon. Every function has a 

name and a command for insertion into the 
document.  

There are three buttons   which we 
use to: 

 Add selected function in Favorites group; 

 Delete selected function from Favorites group; 

Insert selected function into the document. 
 

Arguments ribbon contains descriptions of all 
function, return values and descriptions of every 

argument of the function. 

Button will open a new window 
with a few examples of the selected function. 

 
Functions can be placed on the canvas Math object in 
two ways: by typing commands for creating function 
in Math object (second column in Function ribbon), 
or by double clicking on the function in Functions 
ribbon while the cursor is active in Math object.  

If we choose to insert a function in the first described 
way, the autosuggestion will help us. When we type 

the initial letters of a function command the 
autosuggestion will display all functions which 

commands begins with those initial letters, as shown 
on Picture 22. 

When a function is placed in a canvas, if you place 
the cursor on the function and press the F1 key, the 

function help page will be opened in default web 
browser of your computer. Use this functionality to 
become familiar with function syntax and examples.  
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2.3.3.1 Example: Using of functions 
 

Find the local and global extreme points of function f(x) = x3 - 3x on interval [-3, 3]. 

Solution: 

 We will place an empty canvas object on the document, press  icon, place cursor on 
document and press the left mouse button to place it. Now place the cursor inside the canvas and 
start typing a:=x, use Shift + 6 combination to place the cursor on subscript position and type 3, use 
right keyboard arrow → to move cursor from subscript position, type -3x. In this method we will 
create a function and placed it in the variable a. 

Now we will use the function derivative to find the first derivative of the function, then we will use 
the function nonlinsolve to find the solutions of nonlinear equation where first derivative is equal to 
zero. In this way we will find the critical points, candidates for local extremum. When the cursor is 
on the end of variable a, where we defined the function, press Enter key and new formula object will 

be created with the cursor within it. Type nonlinsolve and the function  will appear, 
in addition we don’t have to type whole name of the function, when we start typing the word after 
the second character typed autosuggestion will show us all functions whose names starts with that 
combination of characters that we typed. So we can type the whole name of function or just select it 
from autosuggestion. Place the cursor on the first argument position and type equation to create 

equation object , on the left side of equation we will insert function derivative  , and 
place variable a inside it. On the right side of equation we will place 0, and as second argument of 
nonlinsolve function we will place value x meaning that we are solving equation with respect to x, 
type =to solve this equation. Solutions are -1 and 1 which are the critical points, we will determine 
what value is the maximum and what is the minimum if we calculate value of function in this points. 

We will use replace symbols function, after we 
type it it’ll look like this

. On first argument 
position type variable a, on second argument 
place type x meaning that in variable a we 
replace value x with third argument, and on 
third argument insert value -1. After we type =, 
we will have value of function in point -1.  
Repeat this process for values 1, -3 and 3 (-3 and 
3 because they are the endpoints of starting 
interval).  

Based on the given results we can conclude that 
global maxim of function is when x = 3, global 
minimum when x = -3, local maximum when x = 
-1 and local minimum when x = 1. 
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3 Ribbons 

3.1 File Tab 
 

 

Picture 23: File tab 

-The New file icon will create a new document with the generic name Document1, New Script 
will create a new script document; 

-To open an existing file press Open icon 

 - To open file stored on the internet press Open Url icon and insert file address 

-To save a file press Save icon 

- Save a file under a certain name press Save as icon 

 -Save a file under a certain name with a read only attribute press Read Only icon 

-Save a file under a certain name with a read only attribute without 
being able to copy content press Read Only Forbid Copy icon 

 -To export the document to a PDF or HTML file, press the Export icon 

-To close a file press the Close icon 

-To exit the application press the Exit icon 

-To print preview a file press the Preview icon 

-To print a file press the Print icon  

         
          

         
          
          
        
   

 

 



________________________________________________MatDeck 

30 
 

3.1.1 Example: File tab 
 

Let’s create a simple document, save it to a desirable destination and close it. We will reopen 
that document, preview it, print it and on then save it like PDF document.  

Solution:  

When we start the MatDeck application, we need to create a new document by selecting the 

New icon . We will save this document with name File Example.mdd and place it in a folder called 

Examples in Desktop. To save it press Save icon  and the new a window will open from which we 
can browse desktop of our computer, select Examples folder, type File Example in File name field 
and press Save button. On the top of the document tab, name will change and now it’s name is File 

Example. At the end, press Close icon  to close the current document. 

Now we will open this document, press the Open icon , from the new window that appears 
browse the Examples folder on Desktop of our computer and select file Example.mdd(file that we 
created a moment ago). After we pressed Open button the document will open.  

When document is open again, press Preview icon  and a new window will open from where 
we can see how the current document looks like before we print it (as shown on Picture 23). Now 

we will press Print icon  , the windows print dialog will open and now select your printer and 
press Print button to print the document.  

At the end we will save this document as PDF format file. To do so, press the Export icon , 
choose the PDF option as the file format. Then select the location where the file will be saved and 
finally press the Save button. 

 

Picture 24: Preview of document 
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3.2 Layout Tab 
 

 

Picture 25: Layout tab 

 

 

 

- To change the appearance of an application use the options available 
in the Application group which allow you to change the style, theme and layout of MatDeck by 
utilizing this group. To apply changes you have made to style and theme you will have to restart 
software 

 

-To alter how you view the program click on the tick boxes 

 

-To change the page setup press the Page icon and select the preferences you wish  

 

The layout thumb nail allows you to pick your preference in terms of the layout and view, it also 
allows you to change the page, frame, margins, header, footer, page numbers, background, grid, 

rulers and canvas properties. 
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Picture 26: Page Setup 

 

-To change the frame via the document settings press the Page Frame icon  

 

Picture 27: Document settings - frame 

 

- To change the page numbers via the document settings press the Page Number icon 

This allows you to choose the print size, source, 
orientation of paper and position of the margins.  

Here you can choose to show the frame or 
not, further more you can positions the frame 

where you want. 
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Picture 28: Document settings - page numbers 

 

-To change the background colour press the Background icon 

 

Picture 29: Select Colour 

 

 

-To change the grid press the Grid icon 

 

Picture 30: Grid tab 

 

 

Choose if you want to show the page numbers and 
you can choose the position of the page numbers. 

You can also pick the caption style. 

Select the colour you want your background to be 
by selecting either selecting a soil colour or making 

your own. 

You can select if you want to show the grid 
and change the size of the grid. This grid 

affects the whole document and when it is 
turned off all grids on the canvas will 

automatically turn off. Also all individual 
settings of local canvas grids will be lost. 
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-To change the ruler press the Ruler icon 

 

Picture 31: Ruler tab 

  

Click the tick box to select weather you want 
to show the ruler. 
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3.2.1 Example: Document style setup 
 

Let’s create new document and set his style same as on Picture 32. 

Solution: 

 From the File tab, press New icon 

 to create a new document. From the 

Layout tab press Page icon  and from 
the orientation section of window that just 
opened pick Landscape option.  After we 
set orientation of document, press Frame 

icon   and new Document settings 
window will open. 

Picture 32: Example - Document style   

Tick the option Show Frame and set left and right option of frame to 20. Now go to Header tab of 
this window and from the drop down list of header font choose Century, size 14 and tick Italic 
option. Move to the Footer tab and for footer font choose Palatino Linotype, size 14, from the 
Footer alignment drop down menu choose Center. On the last tab of the window Page Numbers tick 
Show Page Numbers option, position Bottom Right, caption style Number Only. Close the Document 

Settings window, press Background icon and from the new window that opened choose 

preferred colour of your document (pick same as on Picture 32 if you want). Press the Grid icon , 
from window the Grid & Ruler tick Show grid option and keep the size of grid on 18. 

Now go to Place tab, press Canvas icon  and click on the document to create new canvas 

object. Go to the Document tab, press Canvas Properties icon , on the Border tab of Canvas 
properties window tick Show border option and choose colour for the canvas border (we set it to 
red). 
We just set all document style options that we have for our document to look like document on 
Picture 34. 

  



________________________________________________MatDeck 

36 
 

3.3 Home tab 
 

 

Picture 33: Home tab 

 

 

 

3.3.1 Font group 
 

 

 

3.3.2 Style group 
 

 

 

Picture 34: Style editor 

The home thumb nail allows you to do: editing and formatting of text, paragraph settings, 
style settings and clipboard actions. It also allows you to navigate through the document. In 

addition another feature is that it allows you to find, replace and create content. 

 

We can use settings from this group to change the 
font, letter size, colour and to make the font italic, 
bold or underlined. Also, we can set the subscript 

and superscript mode for the text. 
Default font in MatDeck is Arial, size 12. 

Click the drop down menu to select the font you 
wish to write in and click the adjacent drop box to 

select the size of the font. 

 

Click the drop down box in order to choose 
the type of style you wish from any of the 

following choices. 

When you click on Style icon  the Style 
editor window will open from where we can 

modify and save any of the predefined 
styles (Picture 34).  

If we press  or  
buttons the Style window shown on Picture 

35 will open. 
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Picture 35: Style new /modify 

 

3.3.3 Paragraph group 
 

 

 

Picture 36: Bullet list library 
 

 

Picture 37: Multilevel list library 

 

 

Picture 38: Heading list library 

From this window we can define new or modify 
existing styles and adjust it to our needs. 

We can define / change the name of the style and 
add a description. From the formatting part we can 

define / change the font, size, add Bold, Italic, 
Underline effect, define / change colour of the font, 
define / change the line and paragraph spacing and 

align the text. 
Tick Use it in content creation option if you want to 
use these styles in the document Content styling, 
leave it if you don’t plan to use it for document 

Content.  

We can use the Paragraph group to change line and 
paragraph spacing, to create bullet points, multilevel 

and header lists and to change indent. 

If you want to create bulleting list, select content from 

which we will create a list, press  arrow to open 
the drop down menu, choose and press bulleting or 

numbering list from library. You can use the decrease 

and increase indent options  when one or 
more list items are selected, their list number or sign 

will change depending on indent level. 

If you want to create multilevel list, select content 

from which we will create a list, press  arrow to 
open the drop down menu, choose and press the type 

of list you want to create. You can use the decrease 

and increase indent options   when one or 
more list items are selected, their list number will 

change depending on indent level and multilevel list 
type. 

If you want to create a multilevel list of headings, 

choose  arrow to open the drop down menu, 
choose and press the type of list you want to create 

and press  icon in the end to activate the list 
type you have chosen.  

Indent decrease and increase options , in this 
case, will just move selected headings to the left or 

right without any change on list numbers. 
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3.3.4 Action group 
 

 

 

 

Picture 39:Action group 

 

 

 

 

Picture 40: Align menu 

 

 

 

 

 

 

 

Picture 41: Spell check options 

  

We can use the Action group to align items, check 
spelling, cut, copy, paste and delete items. 

The following icons we can use to: 

Undo an action. 

To redo an action. 

Set alignment of items, when the arrow on this 
icon is pressed a dropdown menu like the one in 

Picture 40 will appear. 

Check your spelling and punctuation. When it is 
pressed the window shown in Picture 41 will appear. 

Copy selected content to clipboard and delete it; 

Copy selected content to clipboard; 

Paste content from clipboard; 

Delete selected content. 

By clicking Spelling button it allows you to change the 
settings in spellings by selecting or unselecting tick 

boxes. 
The settings we can choose in this window are: Spell 

checking is on, Ignore words in uppercase, Ignore 
words that contain numbers, Auto correct with first 

suggested word. 
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3.4 Document tab 
 

 

Picture 42: Document tab 

Purpose of this group is to help you navigate through the documents and make them easier to find. 
Following icons can be use to: 

Zoom in on the file press, or use Ctrl + mouse scroll combination; 

Zoom out of the file press, or use Ctrl + mouse scroll combination; 

Go straight to the first page of the document; 

Go to the previous page of the document; 

Go to the next page of the document; 

Go straight to the last page of the document; 

Select the entire current document;  

Turn on/off title on menu icons (global setting). 

The last two option icons belong to the Select group, but we can place them together in this user 
manual as they complement each other. 
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3.4.1 Search & replace 
 

 

Picture 43: Search & replace 

 

3.4.2 Navigation 
 

3.4.2.1 Content tab 
 

 

Picture 44: Content tab 

 

3.4.2.2 Bookmarks tab 
 

 

Picture 45: Bookmarks tab 

We can use the Find icon to open the menu from 
which we can search for text in the document or 
replace some part of it. Here we can type a text 

we wish to search and replace it with another text 
and we will be able to see all results in Search 

results form. We can choose if we want to search 
text, headings or bookmarks.  

Available options are: Replace all search results, 
Case sensitive and Search whole words only. 

In search results every line that matches the word 
or phrase that has been searched is a hyperlink to 

the place in document where it is found.  

We can use the Navigation icon to open the menu 
with three tabs in it, Content tab, Bookmarks tab 

and Variables tabs. 

From the Content tab we can view content that we 
have created with the Content icon (section 

3.5.12), with a list of all headings in the current 
document. The list is structured depending on 

heading style; every row in the list is linked to the 
heading position in the document.  

For every document in the MatDeck program, the 
content tab will update and show the content 

state of the current document. 

Bookmarks tab contains list of all bookmarks in the 
current document. If we click Update bookmarks 

list we will see a list of all bookmarks in the 
current document. Every bookmark from this list is 

a link to the place in the document where the 
selected bookmark is placed. 

Learn more about bookmarks from the Place tab 
section 3.5.3. 
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3.4.2.3 Variables tab 
 

 

Picture 46: Variable tab 

  

3.4.2.4 Canvas properties 
 

To open properties of the canvas press the Canvas Properties icon, this setting is global for 
all canvases on current document. 

 

Picture 47: Canvas Properties- Border 

 

Picture 48: Canvas Properties- Background 

 

Picture 49: Canvas Properties – Grid & Snap 

Variables tab contains a list of all variables defined in 
the current document. If we click Update variable list 
the list of variables will be displayed in Variable form. 

From the window shown on Picture 47 you can set the 
canvases auto size on or off,  to have borders, their colour, 

thickness, style and  rounding of that border. Setup of 
canvas borders from Document tab->Canvas properties-

>Border tab is a global setting and will refer to canvases in 
whole current document. The default state for this setting 

when we create a new document is Show border on. 

From the window shown on Picture 48 you can set the 
canvases to have background colour. There is an option to 

set this colour to be transparent or solid. 

From window shown on Picture 49 you can set the grid and 
snap of the canvas and also its border. If we already set 

these parameters for one or more canvases in document, 
settings opened from Canvas Properties icon will be applied 
to whole document ignoring the individual canvas settings. 
Grid size can be set in range 5 – 40 pixels, and snap setting 
represent how many parts we would like to divide one grid 

rectangle by. Snap size can be set from 1 to current grid 
size, if set to one this means that grid and snap are the 

same. 
To see usage of canvas grid and snap view Example: Lines 

and snap. 

If you want the Canvas Properties settings to refer only to a 
single canvas, use the right mouse button Properties option 

on it. 
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If you enter the Canvas properties window from the right mouse button context menu, it will have a 
fourth tab called Password. 

 

Picture 50: Password tab 

 

From this tab you can set a password for your canvas, so when you collapse the canvas and you try 
to expand it a new Password window will appear as shown on Picture 51. The canvas will collapse 
into a horizontal line with a right angled triangle in the left corner. To reopen the canvas you must 
click on the triangle in the corner. 

 

Picture 51: Password window 

 

You will have to enter the correct password, the same as the one that you have set earlier in the 
Password tab, to make the canvas expand. 

To remove the canvas password, go to the Password tab (Picture 50), remove the password from the 
text field and press OK. 

3.4.2.5 Collapse All and Expand All 
 

 - To collapse all texts and canvases on the current document use Collapse All icon; 

- To expand every collapsed text or canvas on the current document use Expand All icon.  
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3.5 Insert tab 
 

 

Picture 52: Insert tab 

 

 

\ 

 

 

3.5.1 Text box 
 

 

Picture 53: TextBox options 

 

 

  

The insert thumb nail allows you to place text boxes, images, bookmarks, comments, content, 
links and page break. Furthermore you can also place tables, canvases, maths formulas, graphs 

and 3D graphs. 

To insert a text box press the Text Box icon 
and click on the canvas to position where you 

want it.  

Text box can be placed only in the canvas object of 
the document. You can drag and drop it in the 

canvas object to position it. To resize it move the 
surrounding blue boxes. 

Right clicking on the text box opens up a menu 
that is shown on Picture 53, from this menu we 

can set the background and border colour, border 
thickness and style, turn solid background colour 
on or off, set corner rounding, set transparency. 
The default setting for borders and background 

colour is white (no border). 



________________________________________________MatDeck 

44 
 

3.5.1.1 Example: text box use 
 

Create two text boxes, place them in canvas corners and set the style of your choice. 

Solution: 
 Create a new document by pressing 

the New icon  , press Text box icon 

 and select place on the document 
where you want to place it. New canvas 
object will be created with Text box inside 

it. Place the cursor inside the Text box object and type “This is a left corner of canvas”, resize text 
box by moving the surrounding rectangles so the text that we typed takes up only one line. We will 
change the place of the text box by the drag and drop technique and place it in the top left corner. 
With the right mouse click press, content menu (Picture 53) will open, choose Border colour option 
and set the preferred colour (we set it to blue). Now we will insert another text box, again press Text 

box icon  and select a place on the document where you want to place it. Type “This is a right 
corner of canvas”, resize the text box so it only takes up one line and move it to bottom right corner 
of the canvas (when you want to move Text box, place the cursor above the canvas and drag and 
drop it to the preferred place). Open the content menu of this text box and change its border colour 
(we set it to green), after that open the content menu again and choose Background colour option 
and change them (we set it to blue). On Picture 54 you can see the final look of document. 

 

 

 

3.5.2 Image 
 

 

Picture 55: Picture options 

  

To insert an image object press the Image icon 

  and click on the canvas to the position where 
you want to place it. 

An image can be placed only in the canvas object of 
the document. You can drag and drop it in the 

canvas object to position it. To resize it move the 
surrounding blue boxes. 

To set the picture double click on image object and 
Open Image window will open you can choose a 

image. Right click on the text box and a menu opens 
that is shown on Picture 55, from which we can 

set/change image. 

Picture 54: Text box example 
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3.5.3 Frame 
 

 

Picture 56: Frame options 

 

 

 

 

3.5.4 Bookmarks 
 

 

 

Picture 57: Bookmark window 

 

 

 

To insert a bookmark press the Bookmark icon  

 and click on the canvas to the position where 
you want to place it. 

 Bookmarks can be placed only in the canvas object 
of the document. You can drag and drop it in the 

canvas object to position it.  
From the bookmark window that is shown on Picture 
57 you can Add new or Change existing bookmarks, 
Delete bookmarks, Hide or Show them. Also there is 

an option Hide bookmarks that will hide all 
bookmarks in the document. 

Bookmarks are linked so by clicking Go To you will be 
taken to the place in the document where the 

bookmark is. We can view the list of all bookmarks in 
the document from the Home tab->Navigation icon-

>Bookmarks tab described in section 3.4.2.2.  

To insert a frame object press the Frame icon 

 and click on the canvas on the position 
where you want to place it. 

A frame can be placed only in the canvas object of 
the document. You can drag and drop it in the 
canvas object and position it. To resize it move 

the surrounding blue boxes. 

Right clicking on the frame opens up a menu that 
is shown on Picture 56, from which we can set 

background and border colour, border thickness 
and style, turn solid background colour on or off, 

set corner rounding and frame type. From this 
menu you can also move the frame in front or 

behind other canvas objects. 
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3.5.4.1 Example: Images and bookmarks 
 

Create a new document with two canvases, in every canvas insert a picture with a caption. 

Solution: 

 Create a new document by pressing the New icon  , press Canvas icon and select the 

place on the document where you want to place it, press Image icon and select the position on 
canvas where you want it to be placed. Double click on the image object, a new window will appear 
and from here you have to select the picture which you are placing into the document (we prepared 
the picture of function sin). After the picture is inserted resize it by moving the surrounding blue 
rectangles. Drag and drop the picture to place it in a central position on the canvas. 

We will now insert a Bookmark item, press the Bookmark icon , select and press the place 
under the picture to insert a bookmark. A new window will open, in the Bookmark name field type 
text “Picture 1: Sin function” and press Add/Change button. After we have finished this action the 
document will look like on Picture 58. 

Place the cursor under the canvas and press enter 
on the keyboard a few times, press the Canvas 

icon and select a place on the document 

where you want to place it, press Image icon , 
select and press place on the canvas where it will 
be placed. Double click on the image object; a 
new window will appear from where you have to 
select the picture for placing into the document 
(we prepared the picture of function cos). After 
the picture is inserted, resize it by moving the 
surrounding blue rectangles and drag and drop 
the picture to place it in a central position of 

canvas. 

Insert a new bookmark item, press Bookmark icon  , select and press the place under the 
picture to insert a bookmark. A new window will open, in the Bookmark name field type text 
“Picture 2: Cos function” and press Add/Change button. 

Now go to the Home tab->Navigation icon->Bookmarks tab, press Update bookmark list button to 
create a list of all bookmarks in the current document. A list will have two items, one for every 
bookmark we place in the document. Each item from the list is a link to the place in document where 
the bookmark is set.  

  

Picture 58: Image and bookmark example 
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3.5.5 Comments 
 

 

Picture 59: Comment drop down menu 

 

 

Picture 60: Comment options 

 

 

3.5.6 Link 
 

 

 

Picture 61: Linking 

  

To insert a comment press the Comments icon 

 and click where you want to place it. 

Comments can be placed only in a canvas object of 
the document. You can drag and drop them into a 

canvas object.  
If you press the right arrow from the Comments 
icon a drop down menu will appear which allows 

you to pick the shape of the comments and 
change the background and outline colour (Picture 

59). 

Right clicking on the comments opens up a menu 
that is shown in Picture 60 from which you can 

also change the background and border style and 
colour, select the orientation of the comment... 

You can link the text in a document if you select it 

and click Link icon . The Selected address 
window will open (Picture 61).  

Only regular text could be linked, you cannot insert 
a hyperlink on text which is in the canvas. 

If the text you are linking is an email address, tick 
the option Address is email and in the address field 

we will type mailto: prefix. 
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3.5.7 Table 
 

 Table is one of the objects that can be placed in a canvas. To insert a table press the Table 
icon, chose the preferred size of table and click in the canvas to the position where you want to 
place it. 

 

Picture 62: Insert table 

 

 

Picture 63: Table properties 

 

 

  

You can insert a table in the canvas as an 
independent object. A table inserted in the canvas 

can be resized by moving the surrounding blue 
boxes which you can see when the table is 

selected. 
 

The drop down menu allows you to create a table 
of whatever size you wish. Only tables in the 

canvas can have a name. 
 

A whole table could be selected if you position the 
cursor arrow in the top left angle of the table, to 
select a table row position the cursor arrow left 

from the preferred row, if you position the cursor 
arrow above the column you can select that 

column. 

When you place the cursor inside the cell of the 
table or select any part of it, the Table window will 
open (Picture 63). From this Table window you can 

set: Name of table, Line Width, Line Colour, Cell 
Margin, Cell Colour, Delete column, Insert column 
to right, Insert column to left, Delete row, Insert 

row under and Insert row above. 
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3.5.7.1 Example: Comment, link and table 
 

Insert two comments in the document; create a table with a description of the characteristics 
of each of the comments. Make the descriptions link to external pages with more information about 
them. 

Solution: 

Create a new document by pressing the New icon  , press Comments icon arrow then 

select and press the type of comment you prefer (we inserted  comment), place and press on 
the document where you want to place the comment. A new canvas object will be created with the 
same comment you have choose to place inside it. 
 Place the cursor in the comment text area and type “This is first comment”. Press on the right 
mouse button when the cursor is above the comment and from the content menu select 
Background colour option, from the Select colour window pick a colour and press Ok. Open content 
menu again and choose Line colour option, select the colour of the line and press Ok. From content 
menu choose Solid colour option. Drag and drop the comment to the top left corner of the canvas. If 
you have made an error during the selection of the comment style .Use options from the content 
menu Orientation these will help you to switch comment tail to the preferred side. 

We will now enter another comment, press the Comments icon arrow then select and press 

the type of comment you prefer (we inserted  comment), place and press on the canvas where 
you want to place a comment. Place the 
cursor in the comment text area and type 
“This is second comment”. Do the 
background and line colour change with the 
same steps as we did for first comment.  

Press on the Table icon  and choose 
matrix 3x4 size. To insert it place the cursor 
in the document on the preferred place and 

click the left mouse button. An empty table will appear, in the top row enter the column names as 
shown on Picture 64. Insert the text to the first column and change the colour code of the text then 
change the background and line colours for each of them. You can view colour codes from the 

content menus options for every text individually. 

Place the cursor in the cell with the colour code, hold Shift and 
press the left arrow keyboard key until the whole text in the cell 

is selected. Press on the Link icon  , in the Address field insert 
the url of the internet address which you want to link colour 
code for and press Ok. Repeat these steps for all of the colour 
codes from table. 

Place cursor on the top left corner of the table, the cursor will 

Picture 64: Comments, link and table example 
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change to a black arrow, press the left mouse button to select the whole table. From the Home tab, 

press the Align icon arrow   and choose Align center to align the whole table text. From Font 

group select icon  and change the text font colour in the whole table (we set our font colour to 
orange). 
 

 

3.5.8 Canvas 
 

The canvas is a container object for several types of objects. In the canvas we can place: 
formulas, graphs, images, comments, text boxes, bookmarks, tables, data objects, shapes, arrows, 
lines and trees. To insert a canvas object press the Canvas icon and click on any unused part of the 
document in order to place the canvas. 

 

 

Picture 65: Canvas 

 

 

 

Picture 66: Canvas Properties – border 

 

A Right mouse click will open the menu shown in Picture 65, 
from this menu you can Collapse Canvas and open canvas 

Properties. 
 

 
The Properties option will open the Canvas Properties 

window which refers to the current canvas only. From the 
Properties window we can set a grid and a snap (as 

described in Layout tab icon Canvas Properties,3.4.2.4). 
By default the canvas borders are off. You can choose 

whether the borders are on or off, set their colour, 
thickness, style and rounding all from the Border tab 

(Picture 66). When you select the canvas its border colour is 
blue. 

  

Canvas background colour can be set from Background tab. 
You can resize the canvas if you adjust indents using the 

ruler when the cursor is in the canvas. 
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Picture 67: Password tab 

 

From the Password tab you can set a password for the canvas, so when the canvas is collapsed and 
you try to expand it, a new Password window will appear as shown on Picture 68. The canvas will 
collapse into a horizontal line with a right angled triangle in the left corner. To reopen the canvas 
you must click on the triangle in the corner. 

 

 

Picture 68: Password window 

 

You will have to enter your password, the same as the one that you have set earlier in the Password 
tab, to make the canvas expand. 

To remove the canvas password, go to the Password tab (Picture 67), remove the password from the 
text field and press OK. 

Note: 
Settings that we have described in this section, all properties that can be set from Canvas properties 
context menu option, refers only to the selected canvas. 
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3.5.9 Math 

 
We can use a Math object when we want to insert functions, equations, to define variables 

or to do programming. There are the four ways to insert a Math object in the document: press the 
Math icon and click in canvas on the position where you want to place it; double left mouse click on 
the canvas to the position where you want to place it; single left mouse click in canvas to position 

where you want it (icon  will appear) and begin to type; press the Math icon and click in the 
document, a canvas will be placed and inside it there will be a Maths object. 

 

 

Picture 69: Maths object 

 

 

 

Picture 70: Variable declaration 

 

 

 

 

 

Picture 71: Formula 

 

  

Math objects consist of a formula part which is bordered 
blue on Picture 69 and a formula caption bordered with 
dashed rectangle. Both the formula and caption part will 

resize depending on the content in them.  

Use Include/Exclude from the Evaluation options to 
increase the evaluation speed of a document (excluded 
math objects won’t be considered during evaluation of 
the document). 
If you type Enter in a math object, a new one will be 
created in the line under the current line. Use the left 
arrow key to return to the first math object. 

Operators in the math object can be placed from the 
keyboard, from the Operators tab (described in section 

2.3.1.1) or from Symbols tab (described in section 
2.3.1.2).  

There are some operators which have restriction when 
you want to use them:  

a) := operator can be used only when we define a 
variable in one line (space included); fraction, 

expression, expression in borders  can’t be declared as a 
variable (Picture 70); 

b) { operator can be used only when you want to 
construct a function body after function name() 

combination, in every other case you won’t be able to 
use it. 

If you want to create an equation that will be solely 
used for presentational purposes use combination of 
CTRL and = inside of a math object. After this an equal 
sign will appear inside the math object, after this you 

can type in the math object without an automatic 
calculation occurring. You can alternatively, use the Ctrl 

and F combination that transforms the mathematical 
node into a text node that can be used without 

restrictions. These are all one-sided operations because 
you can’t switch to the math objects rules again. 

 



________________________________________________MatDeck 

53 
 

3.5.9.1 Example: Canvas and Maths 
 

Define function f(a, b, c) = 9 𝑎𝑎𝑎𝑎𝑎𝑎
𝑎𝑎+𝑎𝑎+𝑎𝑎

 and calculate 𝑑𝑑𝑑𝑑
𝑑𝑑𝑎𝑎

(a, b, c) at the points (a, b, c) = (1, -2, 4). 

Solution: 

 Create a new document by pressing the New icon  then press the Math icon and  
select a place on the document where you want to place it, a new canvas object will appear with a 
Maths object inside it. 

Type f:=9*(a*b*c)/(a+b+c) and a new variable will be created. Press the Enter key on the keyboard 
and a new Maths object will be created under the existing one with the cursor in it. We can calculate 
the derivative of function f using the function derivative. Type derivative and a new function will be 

created , place the cursor in an empty node (object with red border inside function), and type 
variable f, move the cursor to the denumerator position, replace letter x with letter c and type =. In 
this way we will calculate and display the first derivation of function f with respect to c. 

Now let us create a new variable x and use replace symbols function to replace the symbol a with 
the value of 1 and store the result in variable x. To do so type x:=replace symbols or use auto 
suggestion that will appear after the second character has been typed. A new function will appear

. In the first empty node enter the derivative function again, and 
calculate  the first derivative of function f with respect to c, in the second node type character a, and 
inside the third node type number 1. The meaning of this function is that we are going to replace 
value a with number 1 in the first derivative of function f and store the result in variable x. 

Now we will create variable y and store the result of the new replace symbols function. Type 
y:=replace symbols, in the first node enter variable x, in the second node enter value b and in third 
enter number -2. At the end create the variable z:=replace symbols, in the first node type y, in the 
second type the value c and in the third type the number 4. We have now replaced values a, b and c 
with numbers 1, -2, 4 respectively, in the first derivative of function f with respect to value c. To see 
the value of first derivative at the point (1, -2, 4) type z=. 
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3.5.10 Graph 
 

We can use graph object when we want to plot a 2D graph. This object can only be inserted 
in a canvas. We have two ways of inserting a graph object in the document: press the Graph icon 
and click in the document, a canvas will be placed and inside it will be the graph object; if we already 
have a canvas in our document and we want to insert graph in it we press the Graph icon and click in 
the canvas to the position where we want to place it.  

To plot a graph you have to define a variable and store data in it. Only data stored in a matrix can be 
plotted, where the first column of a matrix represents the x-axis data and second column are y-axis 
data in the graph. Minimal number of nodes which can be plotted on a graph is two, so the minimal 
matrix size for a plot is 2x2. There are several functions that place data in a matrix, and thus prepare 
them to be drawn in the graph. Those are: curve2d, complexcurve2dre, complexcurve2dimg. 

 

 

Picture 72: Graph object 

 

 

 

Picture 73: Graph dropdown menu 

 

 

 

This is what a default graph will look like once it has been 
inserted into the document (Picture 72). Use the 

surrounding blue boxes to make the graph bigger or 
smaller. 

The graph consists of Title, Axes, Drawing area and 
Legend. If you place the cursor on the title or any of the 

axes and double left click on them, edit mode will open so 
you could set the Title or rename the Axes. 

Legend is displayed in the top right corner of the Drawing 
area and contains all variables that are added on the 

selected graph. 
If you right click on the Drawing area of the graph a 
dropdown menu shown on Picture 73 will appear.  

With Copy As Image and Save As Image, you can copy and 
save graphs as images. You can choose between three 

different levels of picture quality. 

Add Variable option will show a list of all variables created 
in the current document from which you could choose 

what variable you want to plot. 
Remove Variable option will show a list of variables that 
we can plot on our current graph from which you could 

choose what variable you want to remove from the graph. 
Use Remove All Variables option to remove all the plots 

from graph.  
Auto range option will reload the graph and adapt the 

scope of the axes to the data that is stored in our 
variables. 

Curve Manager and Properties opens a new options 
windows, Graph properties and Display properties that 

have detailed described in Graph Tab section (Picture 142 
and Picture 135). 
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3.5.10.1 Example: Graph 
 

Create graph of trigonometric functions sine and cosine on [-2π, 2π] segment and place them 
on the same graph. 

Solution: 

Create new document by pressing the New icon  , press Maths icon  and select a 
place on the document where you wish to place it. A new canvas object will appear with a Maths 
object inside it. Now create the new variable a:=curve2d, this code will create the new variable a 

and store results of function curve2d in it.  

Function curve2d will always be used when we want to draw a graph, it is a function that creates a 
matrix of two columns and the number of rows can be determined in the fourth argument. Simply 
put, the first argument is the function that we want to draw with preferred symbols or values as 
arguments, the second and third are numerical intervals of values that correspond to the symbol 
which appears in first argument function. The fourth argument is the number of samples. In the first 

empty node type sin to create new sine function , then type symbol x as its argument. In the 
second node type type -2*cpi (this is a standard way of inserting constants π in to the document, 
every constant has a character c in front of it), in the next node type 2*cpi and in the last node type 
100 for example. 

From the Place tab select Graph icon , select a place on the canvas where you want to place it, a 
new graph object will appear. From the right mouse click select the content menu and press Add 
variable option, now choose variable a that we created earlier. A sine function graph will appear. 

Let us create another variable b:=curve2d. In the first empty node, type cos to create new cosine 

function  and type the symbol x as its argument. In the second node type -2*cpi, in the next 
node type 2*cpi and in the last node type 100 for example. From the right mouse button click select 
the content menu and press Add variable option, now choose variable b that we have just created. A 
cosine function graph will appear. 
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3.5.11 3D Graph 
 

We can use 3D graph objects when we want to plot a 3D graph. This object can only be 
inserted in the canvas. We have two ways of inserting a graph object in the document: press the3D 
Graph icon and click in the document, a canvas will be placed and inside it there will be a 3D graph 
object; if we already have a canvas in the document and we want to insert a graph in it we will press 
the 3D Graph icon and click in the canvas to the position where we want to place it.  

To plot a 3D graph you have to define a variable and store data in it. Only data stored in matrix of 
vectors can be plotted, every vector represents one point in 3D space with x, y and z coordinates. 
The minimal number of points which can be plotted on a3D graph is four, so the minimal matrix size 
for plot is 2x2. Functions that place the data in such a matrix and thus prepare them to be drawn in 
the 3D graph are: surface3d, curves3d. 

 

 

Picture 74: 3D graph object 

 

 

 

Picture 75: 3D graph properties    Picture 76: 3D plus 

 

This is what a default 3D graph will look like once it has 
been inserted into the document. Use the surrounding 

blue boxes to make the graph bigger or smaller. 
If you right click on the 3D graph object a dropdown menu 

will appear with Save As Image and Properties options. 
Properties option will open a 3D graph properties window 

shown on Picture 75, from which you can select a 
maximum of three variables to be shown on the graph. 
After selecting a variable the 3D surface will open in 3D 
Plus. When you are done with the customization of your 
graph and it is positioned in the preferred way, close the 
3D Plus window and graph will appear in your document.  
If you double left click on the 3D graph object a 3D Plus 

software window will open shown on Picture 76. 
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3.5.11.1 Example: 3D graph 
 

Create a graph of trigonometric functions sin(x2+y2) on [-2π, 2π] segment. 

Solution: 

 Create a new document by pressing the New icon  , press Maths icon , select  
a place on the document where you want to place it.  A new canvas object will appear with a Maths 
object inside it. Create a new variable a:=surface3d, this code will create a new variable a and store 

results of the function surface3d in it . 

Function surface3d will be always used when we want to draw a 3D graph, it is a function that 
creates a matrix of vectors of the size 3x1, every vector is presents a point in space. The first 
argument is the function that we want to draw with preferred symbols or values as arguments, the 
second argument is the first symbol which we are going to change with numerical values, third and 
fourth arguments are numerical intervals of values that will the symbol from second argument will 
take, fifth argument is the number of samples for first symbol, sixth argument is the second symbol 
which we are going to change with numerical values, seventh and eighth arguments are numerical 
intervals of values that the symbol from the sixth argument will take and the ninth argument is the 
number of samples for the second symbol.  

 

In the first empty node type sin to create a new sine function  and type the symbol x, hold Shift 

on the keyboard and press key 6 as its argument (this combination will create ), place the cursor 
inside the power node and type 2. With the right arrow key on the keyboard place the cursor next to 
x2 and type y, use Shift + 6 combination again and insert the number 2. Place the cursor in the 
second empty node and type symbol x, in the third node argument type -2*cpi (cpi is code to create 
constant π), type 2*cpi in as fourth argument, type 50 as fifth argument, type symbol y as sixth 
argument, -2*cpi as seventh argument, type 2*cpi as eighth argument and the number 50 as ninth 
argument. 

From the Place tab select 3D Graph icon , select the place on the canvas where you want to 
place it. A new 3D graph object will appear. From the right mouse button, click on the content menu 

and select Properties option now from the 
dropdown menu of the window shown on 
Picture 75 choose variable a that we created 
earlier. A new window will appear with a 

sine function on a 3D graph. Press icon  
and move the z axis ratio slider to -60, we 
will “shrink” the height of the graph this 
way. Close the 3D Plus window at the end. 
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3.5.11.2 3D Plus 
 

3D Plus is an additional plug in software in MatDeck which is intended for plotting and 
managing of 3D graphs. It has a large variety of options and tools for setting and modifying any part 
of the 3D charts. This makes it an excellent medium for advance use of these graphs. 

We will start with a detailed description of each of the menu items, as well as methods on how to 
use them as effectively as possible. 

 

 

3.5.11.2.1 Data tab 
 

From this tab we can open and save files, create curves, update current surface and manage 
all imported surfaces. 

 

 

 

Picture 77: 3D Plus open 

 

 

 

Picture 78: 3D Plus save 

 

 

 

Picture 79: 3D Plus create 

From this icon  we can open 3D graph files,

 option will open a new window from 
which we should choose an xml file we want to open 

(.xml is file format that is default for 3D Plus software, 
and the only supported file format). 

From this icon  we can save our graph/ file. The 
format is .xml . 

From this icon  we can create a new graph 
independently from the graph that is currently 

drawn, pressing the icon will open a new window 
shown on Picture 80. From this window you have a 

wide range of functions, operators and their 
predefined combinations that can be used. Consider 

this calculator as a keyboard from which you type 
function to draw, you also need to set the x and y 

axes minimum and maximum values and precision. 
Precision is the number of pieces on which intervals 

(axis minimal value, axis maximal value) will be 
divided. 
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Picture 80: 3D Plus Calculator window 

 

 

Picture 81:3D Plus Surfaces 

 

 

 

Picture 82: 3D Plus - Advance view 

 

 

 

Picture 83: 3D Plus - Scientific view 

 

The range for precision is 1-1000, and it is the number 
of samples for selected axis. After we created the 
preferred equation, draw the graph by pressing 

Generate button. There is also a Clear button for 
discarding the current equation. 

Update icon  , where we can update graphs and 
apply all changes that we have made. 

 If we press Surfaces icon  the window shown on 
Picture 81 will open. From this window we can manage 
all created graphs , the options we have available are:  

 select all surfaces; 

 clear all surfaces; 

 delete selected surfaces; 

 update selected surfaces; 

  basic view Picture 81; 

 advance view Picture 82; 

 scientific view Picture 83; 

gradient, how the surface gradient is changing 
that’s how the colour is changing  
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Picture 84: Surface - Basic view 

 

 

 

 

Picture 85: Surface - Advance view 

 

 

 

Picture 86: Surface - Scientific view 

 

 

 

Picture 87:3D Plus – Manager 

 

 

 

 

 

 

Manager icon  will open the window shown on 
Picture 87. From this window we can display or remove 

surfaces from the graph, update them or set them to 
automatic updating. Options we have available are: 

Select all surfaces; 

 clear all surfaces; 

 delete selected surfaces; 

 update selected surfaces; 

 turn automatic updating on or off; 

 pressing this icon will display all selected surfaces 
on the graph; 

 pressing this icon will remove all selected 
surfaces from the graph. 

For every surface the following data is displayed in 
Manager window: Surface Id - shown if data source is 

channel, Surface name, Updated – state of the surface at 
the moment (updated or modified), Status – is selected 

surface displayed on graph (Connected) or not 
(Disconnected) and Origin – which is the data source for 

selected surface. 

In Basic view like in Picture 84, for every surface 
following data is displayed: Name – name derived 

from the data source, Colour – colour for displaying 
surface (one colour or gradient), X Unit– name for x 
axis (changeable from the table), Y Unit – name for y 
axis (changeable from the table), Z Unit – name for z 

axis (changeable from the table). 

In Advance view except data from Basic view we can 
set ratio for every axis. Scale options are Linear 
which is default, Logarithmic and Exponential. 

Scientific view except data from previous views, 
displays scale for every axis (changeable from the 

table) and data origin. 
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3.5.11.2.2 Coordinates tab  
 

 

 

Picture 88: 3D Plus - Resolution 

 

 

 

 

 

Picture 89: 3D Plus - Ratios 

 

 

 

 

 

 

3.5.11.2.3 Surface tab 
 

Options from this group are additional drawing and calculating tools which will help you in 
demonstration of surface features and finding of characteristic. 

When we press Show Peaks  icon, on the surface will appear a thin yellow line that will mark the 
place of the highest peak on the graph. 
If we press the right mouse button anywhere on the surface of the graph, the content menu will 
appear with options Add Bookmark and Reset View point. Bookmarks are represented as yellow semi 
balls on the surface of graphs, as shown on Picture 90. We add them using the right mouse click 
content menu. 

Pressing of  will open a window shown on Picture 88, 
from this window we can set a resolution or step size for 

every axis. Column with values on the right side of Picture 
88 are actual values of steps for every axis.  

Icon  turns on or off displaying of grid on graph, 
default state is grid on. 

Pressing of  icon will open the window shown on 
Picture 89 from which we can set a ratio for every axis. If 
we for example draw a surface with the values of the z 

axis is divided from the values of the other two axes, we 
will change the setting of z axis ration and set it to lower 

state. 

The three icons from the left side of this group 
refer to the choice of the coordinate system.  So 

if we press  icon the surface will be plotted in 

the Cartesian coordinate system, pressing of  
icon will plot the surface in the spherical 

coordinate system and pressing of  icon will 
plot it in the cylindrical coordinate system. 
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Picture 90: Surface peak and bookmark 

 

 

Picture 91: Intersection of surfaces 

 

 

Picture 92: Trihedron on surface 

 

 

 

Picture 93: Surface tangent planes     Picture94: Surface coordinates planes 

To remove a bookmark, press the right mouse button 
while the cursor is on the preferred bookmark, and 

choose Remove Bookmark option. 

Show Bookmarks icon  will display all bookmarks on 
graph if it is turned on, and if we press this icon again it 

will turn off and stop displaying the bookmarks. 

Intersections icon  will find the intersections of 
surfaces (option works only if two or more surfaces are 
displayed) and mark them yellow as shown on Picture 

91. 

Trihedron icon  , if pressed will show intersections 
of surfaces and the coordinate planes from the 

selected place on the surface. We place this item by 
pressing of trihedron icon, after that we have to select 

a place on the graph from which we want this 
intersections to start. There is no limit of the number 

of placed trihedrons, so we can place them as many as 

we want as long as  icon is turned on. 

When Tangent Planes icon  is turned on, we have 
to select points on the surface where we want the 

tangent plane to be displayed, as shown on Picture 96. 
Number of tangent planes that can be drawn is one per 
graph, and if a tangent plane is displayed and we select 
another place on the surface, first plane will disappear 

and the new one will appear. 

 When we press Coordinates plane icon   the 
graph will be filed with planes whose density depends 

on resolution of the axes. There are three options 
under this icon: XY coordinate planes, XZ coordinate 
planes and YZ coordinate planes. These options are 

independent from one another and can be turn on or 
off separately.  
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3.5.11.2.4 Rendering tab 
 

 We select the graph with the left mouse click while the cursor is on the graph, when selected 
the graph surrounding will change colour to grey and cubes around the graph will become visible as 
on Picture 98. 

 

Picture 95: 3D graph when selected 

 

Picture 96: 3D graph – Wireframe 

 

 

Picture 98: 3D graph - Linear interpolation 

 

 

Icons Solid  and Wireframe  refers to the way of 
displaying surfaces of graph. Solid state, shown on Picture 

95, is the default way of displaying graphs but we can 
change it to wireframe state, shown on Picture 96, with 

simple click on  icon. 

Icons Linear and Cubic spline  refers to the way of 
interpolation between the input points. Default option is 
Cubic spline interpolation, as shown on Picture 95, and 

when Linear interpolation option is chosen the graph will 
look like Picture 98. 

The last icon from this group is Origin points  icon and 
when it is turned on, the graph will display the input 

points based on which the graph is drawn. 
They are presented as small yellow spheres on the surface 

of graph.  

 Picture 97: 3D graph - Origin points 
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3.5.11.2.5 Processing tab 
 

 

Picture 99: Surface slicing 

 

 

Picture 100: Surface clipping 

 

 

Picture 101: 3D graph - Isocurves 

 

 

 

Picture 103: 3D graph - Isocurve map 

 

 

If we press Slicing icon  a new window will open in 
which the current graph will be separated into slices like on 
Picture 99. The heights are predefined values on z axis. Use 
Ctrl + mouse scroll combination to move up and down the 

slicing plane. 

If we press Clipping icon  a new window will open in 
which the current graph will be clipped and shown like on 

Picture 100. Use Ctrl + mouse scroll combination to 
translate clipping plane. 

If we press First gradient icon and Second gradient  
icon a new window will open in which the surface of the 

current graph will be painted in colours depending on the 
first and second gradient vector respectively. 

When we press Isocurves icon  a new window will 
open in which the current graph will be displayed with 

isocurves on it. There are three options under this icon: X 
axis isocurves, Y axis isocurves and Z axis isocurves. On 

Picture 101 the X axis isocurves are shown. 

If we press Isocurve map icon  a new window will open 
with the isocurve map shown on Picture 106. 

The last icon from this group is the Projection icon  
with three options: Oxy projection, Oxz projection and Oyz 

projection. On Picture 102 we presented projection of 
current graph with Oyz projection. 

 Picture 102: 3D graph - Projection 
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3.5.11.2.6 View tab 
 

From this tab, we can use tools to customize the background colour of the graph, axes display 
style, brightness of graph surface and we can walk through the graph. 

 

Picture 104: 3D graph - Background colour 

 

 

Picture 105: 3D graph – Lights 

 

  

If we press Walking icon  a new window will open in 
which we can use the keyboard arrows to view the graph. 

Background icon  opens a window shown on Picture 
107 from where we can set the background colour for the 

graph. 

Font icon  opens a window from where we can set the 
style of axes text, font, font style and size, effects and 

writing system. 

Lights icon  will open a window shown on Picture 
105 where we can set the brightness of graphs surface.  
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3.5.12 Content 
 

 

Picture 106: Content 

 

 

 

 

 

 

3.5.12.1 Example: Content 
 

Create document content for ”Document example.mdd” and add a new heading in it then 
update content. 

Solution: 

 We have already created ’’Document example.mdd” with ten chapters and we want to place 
a content within that document. To do so, open up the document and from the place tab press icon 

 , select a  place in the document where you want to place the content.  List of all document 
headings, arranged in content will be created in the document. Every row of this list is a link to the 
place in document where the selected heading was placed. We activate links with a single left mouse 
button click on it.  

Now, inside a document create a new chapter title by creating a heading. Type the chapter title, in 
this example we entered chapter Conclusion at the end of the document, go back to the document 
content and place the cursor on the content and then press the right mouse button.  A menu will 
appear, as shown on Picture 106 from which we will choose the option Update content.  

Next go to Home tab and press the Navigation icon . The tab on the right side of Picture 107 
will open, from where you can also view the content. Every item from this list is also a link and by 
pressing it you will be redirected to the place in document where this chapter begins. 

 

In MatDeck you have an option to generate content and 
place it in the document. To do so press the Content icon 

 and click in the document to the position where 
you want to place the content. 

Content is a list of all the headings in the document 
sorted by the heading type.  

Using the right mouse content menu you have the 
options Update content and Remove content as shown on 

Picture 106. 
There is an option to view and use content list that you 

have generated, from Home tab->Navigation icon-
>Content tab as we already explained in section 3.4.2.1. 
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Picture 107: Content example 

 

 

3.5.13 Page Break 
 
 
 

To insert a Page Break and move the following document content onto a new page, place 

the cursor in the document and press the Page Break icon . 
 
From the selected area in the document till the end of current page, there will not be any content. 
All the document content that follows the line in which we have placed the Page Break will be 
moved to the next page of the document. 
 
To delete the inserted Page Break, place the cursor in front of the content on the page that follows 
the page with Page Break and press the Backspace keyboard button. 
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3.6 Math & Programming tab 
 

 

Picture 108: Math tab 

 
The Math thumb nail allows you to place Math objects, to view variable data, to change measured 

units, to insert matrix, table, equation and interval, to define a Maths settings, to build code as well 
as run it in the console and to deploy document as exe file, to create and edit the script code. 

3.6.1 Getting started with Mathematics 
Double left mouse click- when used in a canvas it creates an empty Math object. 
type a name and := - to assign a value to a variable; or assign a value to an already created a variable; 

 
= - this displays the variable value or the value of a mathematical object/equation;  

 
/ - used for division 

 
Alt + / -create a fraction; 

 
* used for multiplication  

 
 

Shift + 6 (^) –to raise an object or element to a power in math objects 

    

Press * twice, * + * - this combination creates a multiplying operation without a visible 
multiplication sign; 

       

Ctrl + R – selects all formals, math objects and variables in a canvas (you can change fonts and other 
features in one step click) 
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Change units to variable and opposite 
 
If units are on, for example typing m will be meter, to make m as variable 

 
Select m and  

 
Ctrl + U –changes units to variables and vice versa 

 
 

Selecting multiple objects 

 

To add an element or mathematical object to a group of variables/elements, highlight them by 
double clicking the variables themselves or clicking their main element e.g. the line in a fraction or 
the brackets themselves. 

 

The click on the mathematical element in the Basic Math Tab e.g. the bracket sign or the cos sign. 
The mathematical element will appear on the outside of the selected variable/elements, meaning 
that the mathematical element is applied to the variable/element. 

 



________________________________________________MatDeck 

70 
 

If you are adding mathematical elements using keyboard shortcuts or other method, and then 
highlighting the object will not work, you will have to place you your vertical slash just at the end of 
the element and then add the mathematical element e.g. Shift + 6 to add  indices. 

 

Switching units ON and OFF  

To do this, go to Basic math tab and select the Unit subtab. In the unit tab, select or deselect the 
Use Units in Math checkbox, depending on whether you want to use units or not. 

 

 

 

Formula Templates 

To insert a formula from a Formula Template, you will need to go to the Insert tab and then the far 
most left corner. From there, you can select the Group of the Formula Template and the Formula 
Template itself using the two drop down menus. To get the Formula Template GUI shown below, 
click the Show Group button. 
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To then add the formula template to the canvas, double click on the canvas, when the vertical slash 
appears, click on the formula you would like to insert into the canvas. 

 

 
Alt + -  -value or expression to become negative; the negative of existing expression or variable 
value, when the cursor is in front of the variable or expression use Alt – combination to change the 
sign of it; 

 

 

Alt – continue writing the function name; use Alt to insert multi character commands or to skip auto 
suggestion and continue with typing; while you type in the canvas auto suggestion will display all 
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functions that contain the inserted combination of characters, to skip it just use Alt and continue 
with typing; 

 

 

 

 

 
 

Subscript and superscript 

Ctrl + M – to turn superscript mode on or off; 

Ctrl + B – to turn subscript mode on or off; 

Shift + 6 (^) – if Math Style button is down enter a power node in math objects, otherwise XOR 
operator. 

Superscripts and subscripts can be added before or after the pivot letter, just place the cursor on the 
preferred side and use above key combination. 

 

 

Function help 

F1 –place the cursor in the function object and press F1 to open help for the selected function on the 
default internet browser for your computer; 

 

Zoom 

Ctrl + mouse scroll–zoom in, zoom out; 

 

Formulas and Equations 

Formulas themselves must be placed inside a canvas. To open or insert a canvas, open the Insert 
ribbon tab, then select the Canvas icon and left click where on the document you want to place it. 
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MatDeck formulas will be calculated when they are evaluated. For formulas to be evaluated in real 
time and while you’re typing, select the Auto Evaluate Icon in the Math Tab ribbon. 

 

Double left click –when used in a canvas, it creates an empty Math object. 

To use real formula which can be evaluated with operators, switch on the Math Style Icon within 
the Math Tab ribbon; or switch it off for a demonstration Text Formula. 

 
 

     

Ctrl +F excludes math objects (formula) from mathematical rules; use this key combination when 
you want to type full formulas or part of formula for demonstrational purposes, without applying 
any mathematical rules (there are no operators, variables, fractions, functions, …).  

 

When “Ctrl + F” is active, the text of the Math Object will be highlighted in grey. “Ctrl + F” mode can 
be used in any node, however in order to enter graphical math elements “Ctrl + F” must first be 
deactivated. The image below shows a graphical demonstration formula. 

 

To stop the evaluation of :=, use Ctrl + = - when used inside a Math object, it stops the selected 
object from calculating; use this combination when you want to create a presentational formula that 
is excluded from calculation; In order to use “Ctrl + =”, “Ctrl + F” mode must first be deactivated. 
After “Ctrl + =” is used, “Ctrl + F” mode can be activated again.  

* +* - to create multiplying operators whose sign is not visible; when the cursor is behind the value 
or variable use the * + * combination to create a multiplying operation without a multiplying sign. 

 

Alt + /- create a fraction;       

Shift + 6 – enter a power node in math objects; 

Ctrl + M – to turn superscript mode on or off; 
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Ctrl + B – to turn subscript mode on or off; 

Alt + - - selected value or expression to become negative; the negative of an existing expression or 
variable value, when the cursor is in front of the variable or expression use the Alt – combination to 
change the sign of it; 

Use the Left and Right Arrows to move from node to node.  

Right mouse click on a Math/Equation object, then select Exclude from evaluation.  

 
Set style, colour, and size of letters in equations independently by using the font editing tools 
present. 

 
 

Rename variable  
   
To rename a variable, select the variable by double clicking it, then right click on it and choose the 
Rename option. This is seen in the pictures below. 

 
Then select the variable you would like to rename it to and right click it, now the rename option will 
give you the choice of renaming the variable in the canvas or the whole document, click on your 
preferred choice. 
 

 
Now the variable a will have been changed to the variable g. 
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3.6.2 Formula Editor  
 

Use this option to create a formulas that will be excluded from calculations. The formula editor must 
be selected before being used with any formulas.  These kinds of formulas can be used to create 
various expressions for presentational purpose, without limitations and rules that are used in 
standard MatDeck mathematical formulas. When inserted, the field for editing will become grey. 

 

 

 

 

3.6.3 Math 
 

A detailed explanation and example of how to use Math can be found at 3.5.9 
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3.6.4 Matrix 
 

 

Picture 109: Insert matrix 

 

Picture 110: Vector, matrix 
 

 

3.6.5 Math Table 
 

 

Picture 111: Insert Mat Table 

 

Matrix or vectors can only be placed in a math 
object of the canvas.  

 
There are three ways of inserting them in the 

document:  
1) Once the matrix icon is pressed you are able 
to choose the dimensions of your preference 

with the mouse movement.  
2) By selecting a number of rows and columns 

and click on Insert. 
3) Typing vector /matrix functions in a math 

object in the canvas. They will create an empty 
vector of 2x1 size/matrix of 2x2 size. To add 
another column on the right of the current 
cursor position use the Space key, to add 

another row use the Enter key on keyboard. To 
delete a column in which the cursor is in, use Ctrl 
+ Space combination, to delete a row use Ctrl + 

Enter key combination. 

You can place the matrices and vectors one 
inside the other, as shown on Picture 110. 

Math Table can only be placed in canvas.  
There are three ways of inserting them in the 

document:  
1) Once the table icon is pressed you are able 
to choose the dimensions of your preference 

with the mouse movement.  
2) By selecting a number of rows and columns 

and clicking on Insert. 
3) Typing table function in a math object in the 
canvas. It will create an empty table of 1x2 size. 

To add another column on the right of the 
current cursor position use the Space key, to 

add another row use the Enter key on 
keyboard. To delete a column in which the 

cursor is in, use Ctrl + Space combination, to 
delete a row use Ctrl + Enter key combination. 
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Picture 112: Empty tables 

 

3.6.6 Equation 
 

 

Picture 113: Equations and inequalities 

 

 

3.6.7 Interval 
 

 

Picture 114: Intervals 

3.6.8 Variable data 
 

If we want to view vector or matrix 
data stored in a particular variable we can do 
that in two ways: by typing variable name and 
+ =combination in the canvas; or by using the 
Variable data option. The second way is better 
for larger sets of data because it is much easier 
to view them when presented in this way. 

 

To use this option click on the Variable Data icon and 
the window shown in Picture 115 will open. 

 
The dropdown menu, Matrix & Vector Variables, 
contains a list of all the variables in the current 

document that are defined as a matrix or vector. If 
there is no variable with any vector or matrix data 

defined in it, this list will be empty. 
From the second menu, View Data In, you can choose 
how your data will be shown; it can be in a table or a 

graphic mode. 
The Decimal places option defines the number of 

decimal places that will be shown in a variable data 
window. 

With Auto refresh option ticked the variable data will 
refresh on every data change. 

To insert an equation empty node use Equation 

icon . Equation can only be placed in a 
Maths object. Another way to create an equation 

is to type equation while the cursor is in the Maths 
object. 

To create an inequality just replace one or both of 
the equal signs with < or > sign (both forms <= or 

=< are valid). 

To insert an interval empty node use Interval icon 

. Interval can only be placed in a Maths 
object. Another way to create an interval is to type 

interval while the cursor is in the Maths object. 

You can simply delete interval round brackets (, ) 
and replace them with square brackets [, ] to 

create interval of your choice. 
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Picture 115: Variable data 

 

 

 

3.6.9 Angle units 
 

 

 

Picture 116: Angle degrees 

  

This setting refers to the current document and 
represents the measurement units for data 

displaying. 
Default unit for displaying data is radians. 
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3.6.10 Maths settings 

 

 

Picture 117: Math settings 

 

 

 

Picture 118: Show line numbers 

 

 

 

Picture 119: Tooltip in formula 

 

 

 

Once the Math Settings icon is pressed the 
window shown in Picture 117 will open. 

From this window you can choose basic maths 
and programming settings. These settings are 

global and refer to all documents. 

Number of decimal places in results: 0 – 14 
Visible/table matrix rows: 1 - 15 

Visible/table matrix column: 1 -15 
(if vector, matrix or table size is greater that 

selected in the previous two options, the object 
will shrink to selected size and place  symbol in 
the corner; if you click on the symbol the vector / 

matrix will expand to full size) 
Maximum Matrix Elements: define maximal 

allowed size of vectors and matrix 
Table style: Choose one of available styles 

Programing & keyword color, Operator’s color, 
Constant’s color and Variables color are color 
settings for displaying selected object in the 

document. 
 

Auto Evaluation: unselecting this option can make a 
program run faster because the calculations inside math 
objects will only start after we Evaluate the document, 

no calculations will be performed while we type or 
change the formula. 

You can also control this setting by using the Auto 

Evaluation button  . 

This option is automated and it will turn itself off if 
calculations last more than 1 second, it will turn on if 

the operations lasts less than 1 second. 
 

Show line numbers: this option refers to programming 
and whether or not you want to display line numbers, 

as shown on Picture 118. 

Show function arguments tooltips: this option shows 
tooltips for the function arguments, as shown on Picture 

119. 
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Picture 120: Build console 

 

3.6.11 Evaluate 
 

 

Picture 121: Script example 

3.6.12 Build And Evaluate 
 

 

SDK Dir: from this option you can change the 
destination folder for SDK (software 

development kit) installation. The default folder 
for installation of this software kit is root of 

partition, where you can install windows. 

Include Dir: from this option you can change the 
default destination folder for the included 
function (function that includes code from 

other files) 

When the programming script is entered it will 
be calculated automatically But if you change 

any part of the code, it won’t affect the results 
because the script will calculate automatically 
just for the first time. To initiate a calculation 

and run modified script use Evaluate icon. Just 
press it and the calculation will start. 

Evaluate Script refers specifically only to the 
current document and it will recalculate the 

whole document (all math and script objects). 

 

Build And Evaluate recalculates the whole 
document (same as the Evaluate option), but it 
differs from the Evaluate option in the fact that 

the calculation will start in a separate thread 
resulting in higher execution speed. The same 

document can be evaluated much faster by 
utilizing this option. To initiate a calculation use 
the Build And Evaluate icon. Just press it and the 

calculation will start. 

Evaluate script refers only to the current 
document. 

 



________________________________________________MatDeck 

81 
 

3.6.13 Stop script 
 

 

 

 

3.6.14 Build and run exe 
 

 

Picture 122: Application run from console 

 

3.6.15 Deploy exe 
 

 

 

Picture 123: Successful deploy message 

 

 

One of MatDeck’s many options is to build your 
document and run it from the console window. This 

option refers to the current document only. 

To use this option simply create a document you 
would like to run through the console and click on 

Build and Run Exe icon. If you enable build console in 
the Math settings window, the build console window 
will show the progress of your build process. When 
the build finishes a new console window will open 

and run code from the document. 
By using this option you can reach speeds which are 

comparable to the execution speed of high level 
programming language code. 

 

Another useful option is to deploy the 
document you create so it can run 

independently from the program’s installation 
as an EXE standalone application. It’s also 

refers only on current document. 

To use this option simply click on the Deploy 
Exe icon, you will be prompted to select the 

location where your deployed EXE will be 
saved. A successfully created deploy will finish 

with a message as shown on Picture 126.  

There is also an option to stop script 
calculations. To use it just press Stop script 

icon. Use this feature when the script enters 
infinite loops or when you want to stop 

calculations in order to correct a mistake. 

When we press it the calculations will stop in 
current document. 
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3.6.16 Build plugin 
 

 

Picture 124: Successfully installed plugin message 

 

 

Picture 125: Failed to install plugin 

 

3.6.17 Multiline 
  

 

Picture 126: Usage of multiline 

 

3.6.18 Widgets 

 

  

Use this option to define noncontinuous 
functions or other multiline objects. It can only 

be used in formula objects  meaning that 
it will be excluded from calculations and its 

purpose is to be used in documents for 
presentations and documentation. 

You can create or edit widgets from this option 
using implemented MatDeck GUI editor. 

Widgets are document oriented objects and 
this option controls only forms and widgets 

created in the current document. 

Read more about widgets and how to create, 
edit and place widgets in a document, with the 
Widgets User Manual from our documentation 

page. 

With the Build plugin icon you can build 
predefined or custom plugins and create new 

groups of functions with compiled coded 

functions in the   tab. 

The successful installation of the plugin will 
conclude with the message shown on Picture 
127. On the contrary unsuccessful installation 

will conclude with the Picture 128. 
To learn more about plugin creation and usage 

open Plugin user manual in the form of . 
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3.7 Graph tab 
 

 

Picture 127: Graph tab 

 

This tab refers to work done with 2D graph and its settings. Options from this tab can only 
be used if a graph object is inserted in the document and already selected. Option Graph from this 
tab is same as the Graph option from the Place tab that we described in section 3.5.10, so we won’t 
further explain it.  

 

3.7.1 Data table 
 

 

 

Picture 128: Data table 

 

3.7.2 Graph 
 

This option is the same as the Graph option from Place tab, which is described in detail in 
section 3.5.10 so we won’t write more about it.  

 

When you press Data table icon, the window 
shown on Picture 132 will open. From the 

dropdown menu on top of the window select a 
variable and the data you would like to see. The 

menu list will contain all variables that are plotted 
on the selected graph. 

Data set is displayed in a table with two columns, 
the first one represents data for x axis of the graph 

and second column is y axis data. 
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3.7.3 Titles 
 

 

Picture 129: Titles table 

 

 

3.7.4 Curves 
 

 

Picture 130: Curve table 

 

When you press Curves icon the window from Picture 134 will open. From this window we 
can see and manage curves plotted in a graph. Every cell of the table is editable (double click, drop 
down menu, arrow change,…) and you can change: will curves be displayed, change name, title, 
colour, amplifier, multiplier, offset, phase, style, origin of the curve. Amplifier, offset, phase and 
multiplier can be set from the window by choosing which parameters you would like to change by 
setting up the value and pressing apply. Also there is a reset button to return values to default state. 

  

Titles icon will create a table containing all the 
graph variables from the moment of creation. 

So if you make any change in the graph 
(add/remove variable) you will have to create 
new a table because it won’t auto update any 

changes. 
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3.7.5 Graph properties 
 

 

Picture 131: Display - Axis tab 

 

 

Picture 132: Display - Numeration tab 

 

 

Picture 133: Display - Title tab 

 

Picture 134: Display - Background tab 

 

Picture 135: Display - Advanced tab 

Pressing Graph Properties icon will open a window 
as shown on Picture 135, the same as from right 

click content option Graph Properties, from which 
you can configure graph axis and numeration, graph 

title, background colour, margins, perspective 
distance, refresh interval, etc. As we already said all 
this options refer only to the current graph and they 

are not global settings. 
From Axis tab(Picture 135) you can choose if axes 

are going to be displayed or not, change their 
names, width, line style, colour and font. 

Also you can mark the centre of the graph and 
choose its axis colour. 

From Numeration tab (Picture 136)you can choose if 
axes numeration are going to be displayed or not, 

set their font, colour, will it be calculated 
automatically or manually (if you choose manually 
you will have to set a number of decimal places for 
each axis) and set exponential numeration base for 

each axis. 

From Title tab(Picture 137) you can set title, choose 
if it will be displayed or not, set the font and colour. 
You can also choose to show Legend on the graph or 

not. If you plot a large amount of curves, the best 
practice is not to display legend but to use Titles 

table (section 3.7.3) instead. 

From Background tab(Picture 138) you can change 
the background colour of the graph. 

From Advanced tab(Picture 139) you can change 
margins, refresh interval and distance for 3D 

perspective. You can change axes base from decimal 
to logarithmic for both axes or just for one of them. 
There is also the option to Turn Auto Scale On, and 
when it’s turned off you can auto scale the graph 

with Auto Range from right clicking content menu. 
Turn Antialiasing On option will remove “jaggies” 

and the staircase effect from plotted curves when it 
is on. 
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3.7.6 Quadrant 
 

 

Picture 136: Quadrant window 

 

3.7.7 Range 
 

 

Picture 137: Range window 

 

3.7.8 Curve manager 
 

 

To change the curve properties press the Curve Manager icon and the window shown in 
Picture 141will open. This is the same as from right click content option Curve Manager. There is a 
tab for each curve in this window, you can add or remove curves using the Add Curve and Remove 
Curve buttons on top of it. For every curve, the setting is dependent on their features:  

Name field: depending on the source of data for curve this field can be editable or not, if source is 
Device channel name field is editable, if source is Document variable or Database table this field isn’t 
editable and the name of the curve is the same as in the variable or database;  

From this window you can change the range of 
selected graph to any of the present values or you can 
click custom to use your own. To use this option press 
Range icon and the window shown in Picture 141 will 

open. 

Four fields, in the bottom of the picture on the left, 
are editable only if the custom option is selected.  

Press Quadrant icon and window shown in Picture 
140 will open. This option allows you to pick which 

quadrants of graph you wish to be seen.  
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Picture 138: Graph Properties 

If Device channel is selected, Channels group of settings on the right side of the window will 
become editable. You can set the curve Multiply and Offset box. From Channel Table tab you can 
establish channel connection which will be the source of data for the curve. Mark Select Channel 
Server, insert Server IP address and Server port and press Connect button, the connection will 
appear in table below. From Settings tab you can set which columns will be visible in channel 
connection table. To finish the process of creating a channel as a source of curve data, mark the 
connection from the table and press Select button. You can find out more about channels in section 
3.8.6.  

If Document variable is selected as curve source, Available variables drop down menu will 
appear from which you can choose which variable is the source of curve data. The drop down menu 
will contain a list of all variables created in the current document. The option for channel group will 
not be editable in this case. To learn more about variables go to section 2.2. 

If Database table was selected as the curve source, Database tables drop down menu will 
appear from which you can choose which curves from the database will be displayed on a graph. In 
add it on the drop down menu contains the list of options where we established a connection to the 
database from Data tab of software (section 3.8.1). That selected database contains the data for at 
least one of the curves.  

3.7.9 Grid  
 

 

Picture 139: Graph grid properties 

For every curve you can set a colour, font, style 
and thickness. You can also choose to mark on 

curve: source Data point and the way they will be 
displayed (rectangles, circles, x marks); 

interpolated Inner points and the way they will be 
displayed (rectangles, circles, x marks). 

Curve source contain following options: Device 
channel, Document variable and Database table. 

From the window shown in Picture 143 you can 
change the graph grid properties: you can show or 

hide grid, set line width, style, colour, make grid 
resizable, choose it size, show or hide notches along 
axis. Also you can show or hide subdivision, choose 
it size by selecting on how many parts you would 

like to divide the grid rectangle, set subdivision line 
width, style and colour. 
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3.7.10 Toolbox 
 

 

Picture 140: Graph toolbox window 

 

3.7.11 Perspective 
 

 

Picture 141: Perspective view 

 

3.7.12 Interpolation 
 

 

 

Picture 142: Interpolation 

 

From the Toolbox option the window shown in 
Picture 143will open. You can change multipliers for 
each of the axes (their default state is 1), and that 

change will “shrink” or “stretch” the curve 
depending on your input. This option refers to all 

curves on graph. 
To use Auto Roll option select a range by inserting 
the start and finish value for the x axis, move the 

blue slider to select a speed of roll. After you have 
set all parameters press the Start button. 

The Perspective option will put every curve displayed 
on the graph in a different plane and place them 

according to the imaginary axis displayed as dashed 
line in Picture 145. 

To use interpolations press the Interpolation icon and 
the window shown in Picture 146 will open. These 
settings refer only to the currently selected graph.  

If number of nodes in the source data for the curve is 
too small and you want to make the curve line more 

round because of its sharp edges, select the 
interpolation method you prefer, set number of 

interpolation points and press Apply button. 
Number of interpolation points is a number in the 

range of 1-99 and represents number of points that 
will be placed between two source nodes. 
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3.7.13 Regression 

 

 

Picture 143: Regression 

 

3.7.14 Example: Graph tab 
 

Sketch the graph of f(x) = (x - 1)3+ 1 on interval [-1, 3] with the number of samples set to 20. 
Create a Data table for this function, interpolate function curve with Hermit spline interpolation, 
display graph only in first quadrant, the “shrink” function will double its size with respect to x axis, 
display input data points with blue circles and colour graph curve in orange. 

Solution: 

Create a new document by pressing the New icon  , press Maths icon , select a place on the 
document where you want to place it, a new canvas object will appear with a Maths object inside it. 
Create a variable with code a:=curve2d and a new variable with function inside it will appear

. In the first argument node type (x-1), hold Shift and type 6, that will create 

a power function node  and then type -1 at the end. In the second argument node -1, in the 
third argument node type 3 and in the fourth one type 20. 

  

From the Place tab select Graph icon , select a place on the canvas where you want to place it; a 
new graph object will appear. From the right mouse click content menu select Add variable option 
and choose variable a we created earlier, a function graph will then appear. 

Select the graph object by clicking on it once and pressing the Interpolation icon . Tick the 
Hermit spline, set Number of interpolation points to 15, press apply and close this window. Notice 
that the graph curve is now much more rounded than before.  

To use regressions press Regression icon and the 
window shown in Picture 147 will open. These 

settings refer only to the currently selected graph. 

Use this option when you want to find a function 
that best fits source data. 

Number of regression points is a number in the 
range of 1-99 and represents the number of points 

that will be placed between two source nodes. 
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Press Curve Manager icon , press the red quadrant  and the Select colour window 
will appear, set colour to orange and press OK. Tick on Data point’s option, select the Circle from the 

drop down menu and set colour to blue . With the previous settings we 
change the graph colour to orange and the draw input data points with blue circles. 

Press Toolbox icon , and for the x Axis Multiplier set the value to 2.0. That will double the size of 

the graph with respect to the x axis.  

Press Quadrant icon , then tick option 1, press apply and close this window. After this setting 

you should only see the first quadrant of the graph.  

Now press Titles icon , a table will appear in the canvas. Place the cursor in the title column and 
type f(x), now place the cursor in the top left corner of  the table (cursor arrow will change to black 

arrow), open Home tab and from the Align icon drop down menu   select Align Center to align 
all table items. 

Place the cursor above the Title of the graph object and double click on title text. A text field will 
open, type f(x) and press the Enter key from the keyboard. 
If you have done all the tasks from this example, the graph at the end will look like the graph on 
Picture 147. 

 

Picture 144: Graph tab example 
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3.8 Data tab 
 

 

Picture 145: Data tab 

From this tab you can connect your document with SQLite database or excel document to 
import and export your data, so they can be saved in other extensions. Also you can make a 
connection through TCP protocol with other computers or any other device that supports TCP IP 
protocol connection. This option allows you to transfer and display data in real time and opens up a 
wide range of ways to import, process, display and store data. 

To use any of connecting options from this tab a document must to be created and every 
connection refers only to the current document. 

 

3.8.1 DB Manager 
 

MatDeck uses SQLite database management system to store and import data. If you would like to 
edit .db files created from MatDeck application you will have to install some SQLite viewers or tools, 
such as: DB Browser, SQLite studio, SQLite Manager for Firefox, … 

 

 

 

 

Picture 146: DB Manager 

 

 

 

 

Use DB Manager Option to create a connection 
with the database. To create a new database press 
Create Database button, a new window will open 

from which you should create a database file with a 
name and location you prefer and then press 

 button. If you want to connect to an 
existing database use Select Database button, 

choose database file and press  
button.  

When you make a connection with a database the 
Connect button will change to Disconnect and it will 

appear like this . To disconnect from 
a database just press this button. 

http://sqlitebrowser.org/
http://sqlitestudio.pl/
https://addons.mozilla.org/en-US/firefox/addon/sqlite-manager/
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3.8.2 Export to database 
 

 

 

 

Picture 147: DB export properties 

 

 

 

3.8.2.1 Example: Export to database 
 

Export values of sine function on interval [-2,2] to database. 

Solution: 

 Create a new document by pressing the New icon  , press Maths icon , select a place 
on the document where you want to place it, a new canvas object will appear with a Maths object 
inside it. Now create a variable with code a:=curve2d and a new variable with the function inside it 

will appear . In the first argument node type sin and insert the symbol x 
inthe sine function. In the second argument node type -2, in the third argument node type 2 and in 

the fourth type 50.  

Press the DB Manager icon  then choose the Create database button. A new window will 
open, create a new database file base.db on the Desktop of yourcomputer. Type base in the File 

name field, choose Desktop from the list and then press the Save button. Press  
buttom,the connection to the database is established. The connect button will change to 

 button. Press Close to exit this window. 

Press the Export icon  and select a place on the canvas where you want to place it, a new 

Database export object will appear . Place the cursor above this object and using the 
right mouse click content menu choose Properties and the Export Variable To Database window will 

To create an Export database object press Export 
icon and click on a position in the canvas where you 
would like to place it. This is how Export database 

object looks like . 

Right mouse click opens up the content menu from 
which you should choose Properties option that will 

open a window shown in Picture 151. 
From the drop down menu of this window you can 
choose the data of variable which you would like to 

be exported to database. List of variables contains all 
variables created in the current document. After you 

selected a variable press the Add button, variable 
will appear in the table of variables to be exported. 
To remove a variable from this table, select it and 

press the Remove button. 
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open. In the Document Variables menu, variable a is selected 
as only variable in this document, and all we have to do is to 
press the Add button. Variable a will appear in the list under, 
press Close to exit this window. The database export data 

object will now looks like this  meaning 
that we exported data from variable a to our database. 

Now we have a SQLite file base.db on the Desktop of our computer in which we have saved a matrix 
with two rows, in the first row we have placed data for the x axis and in the second we have placed 
the corresponding y axis data. 

 

 

3.8.3 Import from database 
 

 

 

 

 

Picture 148: DB import properties 

 

 

 

 

 

3.8.3.1 Example: Import from database 
 

Import data we exported in example 3.8.2.1 and draw 2D graph with them. 

 

To create an Import database object press the 
Import icon and click on a position in the canvas 
where you would like to place it. This is how the 

Import database object looks like . 

The right mouse button click opens up the 
content menu from which you should choose the 

Properties option that will open the window 
shown in Picture 152. 

Press Select Database button to choose a db file 
from which you would like to import data from. 

Press Add Variable button and a #variable tab will 
appear, if you want to insert data from more 

variables press Add variable again and for each 
variable you will have one tab.  

From Read  table in the drop down menu, select 
the variable for which data you would like to 

insert. From Write table in the drop down menu 
select the variable from the document you would 

like to store the data in. 
To remove a variable which data you have 

imported, select the tab from where you inserted 
the variable data and press Remove variable 

button. 
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Solution: 

 Create a new document by pressing the New icon  , press Maths icon , select a place 
on the document where you want to place it. A new canvas object will appear with a Math object 
inside it. Create the variable with code b:=0, this is the variable in which we are going to import data 
from the database file.  

Press the DB Manager icon  and then press the Select database button. A new window will 
open, select the Desktop of your computer, selected the base.db file and press Open button. Press 

the  button and now the connection to the database is established. The connect 

button now has changed to  button. Press Close to exit this window. 

Press the Import icon   then select a place on the canvas where you want to place it, a new 

Database import object will appear . Place the cursor above this object, using the 
right mouse click content menu choose Properties and the Import Variable From Database window 
will open. Press Select database button and from the new window that has just opened choose 
base.db file from your Desktop. Press Add Variable button and a new tab will appear. There are two 
drop down menus, Read From Table with 
variable a selected (this is the variable in the 
database where we have stored our data) and 
Write To Variable with variable b selected (this 
is the only variable in our current document, 
you can always create another variable and 
choose it for data import). Press Close button 
to exit this window. 

The database import data object will now looks like 

this  meaning that we have 
imported data from the database to variable b. Now 
we shall draw the graph with this data. 

From the Place tab select Graph icon then select a 
place on the canvas where you want to place it; a new 
graph object will appear. Using the right mouse button 
click content menu, select Add variable option and 
choose variable b. A function graph will appear. 

As you can see this is the graph of the sine function on 
interval [-2, 2]. The data we have exported earlier to 
the database were successfully imported and shown 
on the 2D graph. 
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3.8.4 Export to excel 
 

 

 

Picture 149: Excel export content menu 

 

 

 

 

Picture 150: Excel export object 

 

 

 

 

 

Picture 151: Excel export 

Picture 152: Excel export remove variable 

To create the Excel export object press the Export icon and 
click on the position on the canvas where you would like to 

place it. This is how the excel export object looks like

. 

Pressing the right mouse button opens the content menu 
from which you should choose the Properties option that 

will open the window shown on Picture 153. 

Press New and select a folder where you want to create a 
new excel file or press Browse to select existing excel 

document in which you want to export data. Select a Sheet 
from the drop down menu and the variable which data you 

are exporting (a list of variables will contain all variables 
created in current document), in Starting Address type 

number of an excel cell from which the data will be written 
and select Max. Samples value. We suggest leaving this 

value to a default. 
 Select Orientation and press Add button. 

A new row will appear in the table of connected variables 
where you can view all parameters set in this window. 

To remove a variable connection from table, select the row 
you want to remove and press Remove selected button.  
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3.8.4.1 Example: Export to excel 
 

Export values of the sine function on the interval [-2, 2] to excel file. 

Solution: 

Create a new document by pressing the New icon  , press the Maths icon , select a place on 
the document where you want to place it, a new canvas object will appear with a Maths object 
inside it. Create a variable with code a:=curve2d and a new variable with functions inside it will 

appear . At the first argument node type sin and insert the symbol x in the 
sine function. In the second argument node type -2, in the third argument node type 2 and in the 
fourth type 20. 

 

Press the Export icon , select a place on canvas where you want to place it, a new Excel export 

object will appear . Place the cursor above this object, from the right mouse click 
content menu choose Properties and an Excel Writer Object window will open.   

Before we continue, we have to create an excel file in which we are going to export data. Therefore 
we created export.xlsx file on the Desktop. Press the Browse button and a new window open, 
choose export.xlsx file from your Desktop. In the Sheets field choose the excel sheet where the data 
will be placed, a Variable field will automatically display variable a (because it is the only variable in 
current document). In the Start address box, type the excel cell position as a starting cell for data 
export, (we inserted A1 in this field), choose Max. Samples value (always insert a larger number than 
your current data size, because of a possible change the size of variable a), choose Orientation of 
exported data (we left Vertical option) and press Add button. A table of export will add one row with 
variable a, that we have just selected to export data from. Press the Close button to exit this 
window. 

Excel file export.xlsx is locked for read/edit during the export process. We can’t open it until the 
current MatDeck document is opened.  After we close this document, we can open a excel file and 
see the exported data. 

After the closing of the Excel Writer Object window, the Excel export object will look like this

. 
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3.8.5 Import from excel 
 

 

 

Picture 153: Excel import content menu 

 

 

 

 

Picture 154: Excel import object 

 

 

 

 

 

 

Picture 155: Excel import 

To create an Excel import object press the Import icon 
and click on the position in the canvas where you would 

like to place it. This is how excel import objects looks like.

 

Right mouse click will open the content menu from which 
you should choose the Properties option that will open a 

window shown on Picture 157. 

 
Open the drop down menu. Press Browse and select the 

excel document from which you want to import data. 
From the drop down menu Sheets select the one that will 
contain the data you want to import, select a variable in 

which the data will be placed (list of variables will contain 
all variables created in current document).Insert range 
where data is placed in excel document (Start and End 
Cell), this range specifies the size of the variable after 

insertion of data and press the Add button. 
A new row will appear in the table of connected variables 

where you can view all parameters set in this window. 
 

If you want to insert several rows/columns from an excel 
document to a variable, select the option Combine 

samples to single matrix. You will have to specify the 
range for every row/column of data you are inserting and 
add it in the table of connections. Don’t forget to choose 
the same destination variable when you add connections. 

 
To remove a variable connection from a table, select the 
row you want to remove and press the Remove selected 

button.  
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3.8.5.1 Example: Import from excel 
Import data we exported in example 3.8.4.1 and draw 2D graph with them. 

Solution: 

 Create a new document by pressing the New icon   and then press the Maths icon , 
select a place on the document where you want to place it, a new canvas object will appear with a 
Maths object inside it. Create a variable with code b:=0, this is the variable in which we are going to 

import data from the excel file export.xlsx. PresstheImport icon , select a place on the canvas 

where you want to place it, a new Excel export object will appear . Place the cursor 
above this object, right click with your mouse on the content menu and choose Properties and an 
ExcelReader Object window will open.   

Press the Browse button and from the new windows that you have just opened choose export.xlsx 
file from your Desktop (file where data was exported). In the Sheets field, choose the excel sheet 
where your data is saved, the Variable field will automatically display variable b (because it is the 
only variable in current document). If there is no variable in the document or you simply want to 
import data in a document, press Add New Variable button, we left variable b as an import location. 
In the Start Cell field, type the excel cell position as a starting cell from which data will be imported 
(we inserted A1 in this field), in the End Cell field. Type the excel cell position as an ending cell from 
which the data will be imported and press the Add button. In the table of imports there will be a 
new row with the variable b that we have just chose to import data to. Press the Close button to exit 
this window.  

After the closing of the Excel Reader Object window, the Excel import object will look like this

meaning that we have imported data from the excel file to variable b. Now we 
shall draw a graph with this data. 

From the Place tab select the Graph icon , click 
the place on the canvas where you want to place it, 
a new graph object will appear. Right click on the 
content menu and select the Add variable option 
and choose variable b. A function graph will appear. 
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3.8.6 Export to channel 
 

 

Picture 156: Channel export content menu 

 

 

 

Picture 157: Your IP option window 

 

 

Picture 158: Properties option window 

 

 

 

3.8.6.1 Example: Export to channel 
 

Export values of sine function on interval [-2, 2] to channel. 

Solution: 

Create a new document by pressing the New icon  , press the Math icon , select a 
place on the document where you want to place it, a new canvas object will appear with a Maths 
object inside it. Create a variable with the code a:=curve2danda new variable with functions inside it 

To create a channel export object, press the 
Export icon and click on the position in the canvas 
where you would like to place it. This is how the 

channel export object looks like.

 

The right mouse click opens a content menu 
shown on Picture 160 from which you can choose 

Properties and Your IP options. 

Your IP option opens a window also shown on 
Picture 160, where the Server IP address and 

Server listening port fields are already filled. Both 
fields refer to your computer (named server in 
their descriptions). The Server IP Address field 

contains public IP address of your rooter (if your 
computer is connected to internet) or your 

default localhost IP address 127.0.0.1 (if your 
computer is offline). Server listening port is by 

default set to 1501. 

The Properties option opens a window shown on 
Picture 162 from which you can choose the 
variable you would like to export. A list of 

variables in the drop down menu consists of all 
the variables created in the current document. 

After you choose a variable press the Add button 
and a variable will appear in the table meaning 
that you exported its data through the channel. 

To remove it from the table of exported variables 
select the row within the table and press the 

Remove selected button. 
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will appear .  For function first argument type sin and insert the symbol x 
inthesine function. For the second argument type -2, in the third argument type 2 and in the fourth 
type 30. 

 

Press the Export icon , select a place on the canvas where you want to place it, a new 

Channel export object will appear . Place the cursor above this object, using the 
right click select the content menu and choose Properties and Export Variable To Channel window 
will open. 

In the document Variables menu, variable a is selected as the only variable in this document and all 
we have to do is to press the Add button. Variable a will appear in the list under, press Close to exit 

this window. The channel export data object will now looks like this  meaning that 
we have  exported data from variable a to channel. 

Now we have opened the channel from which we are sending the data via variable a as a matrix with 
two rows, in the first row we have placed data for the x axis and in the second, y axis data. 

At the end we will save the file by pressing the Save icon  from the File tab, from the Save As 
window choose where you want to save the file (we placed it on Desktop), type channel in the File 
name field and press the Save button. 

 

 

3.8.7 Import from channel 
 

 

 

Picture 159: Channel import content menu 

To create a channel import object press the Import 
icon and click on its position in the canvas where 
you would like to place it. This is how the channel 

export object looks like . 
Right mouse click opens a content menu shown on 

Picture 162 from which you can choose the 
Properties option. 
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Picture 160: Channel import variable – Channel Table tab 

 

 

Select the Select Channel Server option to connect to the preferred server (insert server IP address 
and port) by pressing the Connect button. After connection has been established, the table will be 
filled in with available variables that were exported through channel from the server that you have 
chosen. 
Select row from the table that contains data you want to import, from drop down menu in bottom 
right corner of this window, choose the variable in which you want to import that data and press 
Select button.  The table will change colour and enter to non-editable mode. 
Write to variable drop down menu contains all variables created in current document. 
To disconnect between the connected channel table row and variable, press Deselect button and the 
table will become editable again. To remove one of the tabs that contains channel – variable 
connections, select that tab and press Remove variable button. 

 

Picture 161: Channel import variable – Setting tab 

From the Settings tab, shown on Picture 164, you 
can choose which columns will be displayed in 

the Channel table tab when we establish 
connection to server. These settings refer to 

current variable tab; it is not a global setting for 
all variable tabs. 

The Properties option opens a window shown on 
Picture 163 from which you can import and 
remove variables by pressing the buttons Add 
Variable and Remove Variable from the top of the 
window. 
The Add Variable button will create a new tab 
with the name #variable. Every tab refers to one 
variable, so you can establish multiple imports by 
creating several tabs. There are two sub tabs 
inside the variable tab: The Channel table tab is 
where you can manage the channel connection 
and the Settings tab is where you can set visibility 
of the columns for the first tab. 
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3.8.7.1 Example: Import to channel 
 

Import data we exported in example 3.8.6.1 and draw 2D graph with them. 

Solution: 

 Create a new document by pressing the New icon  and then press the Math icon , 
select a place on the document where you want to place it, a new canvas object will appear with a 
maths object inside it. Create a variable with the code b:=0, this is the variable in which we are going 
to import data from the channel that we have created in example 3.8.6.1.  

Before we continue with data importing, we have to open a file in which we can export data. This is 
required because the channels transfer data through TCP protocol, meaning that you have to open a 
channel (we did this in “chanell.mdd” file) and keep it open until data transfer is finished.  

Press the Import icon  and select a place on the canvas where you want to place it, a new 

Channel export object will appear . Place the cursor above this object, from the right 
mouse click content menu and chose Properties and the Import Variable from Channel window will 
open. Press the Add Variable button and a new tab will appear in the channel table. Select a row in 
the table (this is the only row in the table which presents the channel that we have opened in 
“chanell.mdd” file), in the Write To Table drop down menu, select the variable b (variable in which 
we are going to store data) and press the Select button.  

After the closing of the Import Variable From Channel window, the channel import object will look 

like this meaning that we have imported data from channel to variable b. Now we 
shall draw a graph with this data. 

From the Place tab select the Graph icon and select a place on the canvas where you want to 
place it, a new graph object will appear. From the right mouse click content menu and select the Add 
variable option and choose variable b. A function graph will appear. 

As you can see, this is a graph of the sine function on the 
intervals [-2, 2].The data we have exported earlier 
through the channel was successfully imported and 
shown on a 2D graph. 
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